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Document Overview 
This document provides a step-by-step guide for Coalition Portal staff who are assisting providers. 

 Purpose of this Document 

The purpose of this document is to provide coalition users with a reference document to successfully 

navigate and perform business processes included in Release 4.2 of the Provider Portal/Coalition Portal. 

 Intended Audience 

The intended audience for this document includes coalition staff responsible for processing Provider 

Portal profiles, contracts, enrollments, attendance, and reimbursement, as well as staff responsible for 

providing technical assistance to Provider Portal users. 

What’s New in this User Guide? 

Provider Section: Updated text for SR-20 Exhibit 4: Holiday Schedule; Updated text and screenshots for 

Enrollments – VPK (Request/Change Enrollment) and Managing VPK Enrollment (Class Change). 

Coalition Section: Updated text and screenshots for Payment Transmittal File; New text and screenshots 

for Payment Verified Work Queue, Line Item Adjustments, and SR Match Program Changes for 2019-20. 

Assistance 

If you have questions about any of the material in this user guide or about any processes not covered by 

this guide, please contact the Office of Early Learning Service Desk at Service.Desk@oel.myflorida.com or 

(850) 717-8600.  

mailto:Service.Desk@oel.myflorida.com
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Accessing the Provider Portal  
The link to access the Provider Portal is https://providerservices.floridaearlylearning.com. 

Creating a Provider Portal Account 
First-time Provider Portal users must register for an account to access the Provider Portal. Provider Portal users 

with multiple provider sites should begin by registering only one site location. This could be the provider’s primary, 

flagship or main location. Once a Provider Portal account registration request is approved for one provider site, the 

provider user will be able to create accounts for additional sites after logging on to the Provider Portal. 

 

Click the here link to start the new account registration process and the following page will display:  

 

 

A Provider Portal user must enter the taxpayer identification number (from the provider), the provider 

identification number (from the early learning coalition) and the Department of Children and Families (DCF) 

license, registration, exemption number or type the word “EXEMPT”. Providers may enter “EXEMPT” if they do not 

have an exemption number from DCF.   

The Provider Portal user must click the Verify License Details button to complete step 1 of the Provider Portal 

account registration process.  

 

 

 

 

 

https://providerservices.floridaearlylearning.com/
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If a match is found for the submitted information, the following message will display:  

 

If the information is not correct, click the No button and contact the local early learning coalition.  

If the information is correct, click the Yes button. On the next screen, the registration information will be 

populated by the system, with the exception of User Information. 

 

If a match is not found for the provider information, the following message will display: 
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After filling in the required information (noted with a red asterisk *), the Provider Portal user must click the 

Register button to complete the registration process. 
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After clicking the Register button, the following message may display:  

 

Click the Select this radio button to accept the standardized United States Postal Service (USPS) address or the 

Entered Address if the USPS Address is not found. Then, click the Apply button to continue. If the Provider Portal 

user clicks the Close button, the user will be taken back to the previous screen to re-enter the address information.  

Once the Provider Portal user submits an account request, the following page will display:  

 

The Provider Portal user should access the email address used in the account and find the email sent by 

DONOTREPLY@oel.myflorida.com. 

 

If the registration request is approved, the following email will be sent by DONOTREPLY@oel.myflorida.com.  
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The Provider Portal user can log on to the Provider Portal at https://providerservices.floridaearlylearning.com.  

Troubleshooting a Provider Portal Account Error Message 
If the Provider Portal user receives the following message, contact the local early learning coalition to verify that 

the taxpayer identification number matches the OEL database.  

 

If the Provider Portal user receives either of the following messages, contact the local early learning coalition to 

determine if a provider portal account has already been created.  

 

 

If the Provider Portal user receives the following message, contact the local early learning coalition to determine if 

the user name (email address) has been used in the Family Portal. The coalition may need to consult with OEL to 

make this determination. If a user name has been used in the Family Portal, even if an application was not created, 

OEL will have to remove the user name from the database so it can be used in the Provider Portal. If a provider has 

improperly used a user name to complete SR or VPK applications for a parent, the provider must contact that 

parent to get a replacement user name for that application so the provider’s user name can be used in the 

Provider Portal. Another option is for the provider to pick another user name to use in the Provider Portal.   

 

 

  

https://providerservices.floridaearlylearning.com/
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Provider Portal Returning User 

 Log on Process 
Provider Portal users who have already created a user account can log on from the Provider Services welcome 

page by entering the user name and password created during the account process. Click the Log On button to 

continue. 

 

 

 Password Recovery 
If the Provider Portal user cannot remember the password, the user can click the Forgot my password link. 

 

 

Clicking the Forgot my password link will display the following page: 
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The Provider Portal user must know the email address used for the account. Once the Provider Portal user enters 

an email address and clicks the Continue button, the following page will display: 

 

The Provider Portal user should then access the email account used for the account and find the email sent by 

DONOTREPLY@oel.myflorida.com. 

 

Once the Provider Portal user clicks the here link, the following page will display: 

 

 

The Provider Portal user must enter the user name (email address), new password and confirm the new password. 

After entering the required fields, click the Reset Password button to continue.  
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If the Provider Portal user successfully changes the password, the following page will display:  

 

 Change Password Process 
A Provider Portal user can change the password at any point by clicking the Change my password link. 

 

Clicking the Change my password link will display the following page: 

 

The Provider Portal user must enter the User Name (email address), current password, new password and confirm 

the new password. After entering the required fields, click the Change Password button to continue. 
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If the Provider Portal user successfully changes the password, the following page will display:  
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Provider Dashboard 
After logging on to the Provider Portal, the following page will display:  

 

 Update Provider Portal User Account Information 
Provider Portal users are able to update their user information – name and phone number – associated with their 

email address. If the name associated with an email address is blank, the user can add the first and last name. If a 

name associated with a standardized email address (e.g. Info@JimsHouseofSmarties.com) needs to be changed 

due to a director or other staff leaving, the first and last name can be changed as long as another user has access 

to that Provider Portal account. If no one has access to the Provider Portal account, contact your local early 

learning coalition to submit a ticket to the OEL Service Desk.  

Click on the gear icon. 

 

The following will display. Click the Account Information button.  

 

 

 

mailto:Info@JimsHouseofSmarties.com
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Enter the additional information and click Save.  
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Multiple Sites 
If the Provider Portal user registered a provider site that shares a taxpayer identification number with multiple 

sites, all of the sites with a shared taxpayer identification number will appear in a dropdown list for that Business 

Administrator.  

 

Manage Sites 
Providers with multiple site locations can use this feature to manage additional sites. Click the Manage All Sites 

link to add new provider sites. Additional sites can only be added if the sites share the same taxpayer identification 

number. This function will only be needed if the provider site is not found in the OEL database. Sites that share the 

same taxpayer identification number will automatically be assigned to the Business Administrator who registered 

the first provider site with the same taxpayer identification number.  
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After clicking the Add Site button, the following message will display:  

 

If the new provider site matches, the location information will be pre-populated.  
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If the new provider site does not match, the location information must be entered by the Provider Portal user.  
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After clicking the Register button, the following message may display:  

 

Click the Yes button to accept the standardized United States Postal Service address. Click the No button to go 

back to the previous screen to re-enter the address information.  

Manage Users 
Click the Manage All Users link to edit, add, and inactivate provider site users.   
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To edit the role of a Provider Portal user, click the Edit button.  

 

Provider User Roles: 

 Business Administrator – Able to edit the provider profile and principal business information that is 

shared among associated provider sites; able to add provider sites and users; submit profiles and 

profile updates; and create contracts. This role would typically be assigned to an owner.  

 Site Administrator – Able to edit the provider profile associated to their site add provider users for a 

site, but cannot create a new site. This role would typically be assigned to a principal or director.  

 User – Able to perform administrative tasks based on permissions granted by the Business 

Administrator or Site Administrator. This role would typically be assigned to teachers and aides.  

 

After changing the role, click the Save button to continue.  

 

To add a user, click the Add User button.  
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In the user name field, the Provider Portal user will enter the email address of the new user. If the user already has 

an account in the Provider Portal, the user role must be selected. Click the Save button to continue.  
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In the user name field, the Provider Portal user will enter the email address of the new user. If the user does not 

exist in the system, the user’s information and role must be entered. Click the Save button to continue.  

 

Once the new user has been added, an email will be sent to the new user by DONOTREPLY@oel.myflorida.com. 
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The User role has a set of permissions that can be individualized for each User. Each option is unchecked by default 

and must be checked to add to the User. Click the Save button to continue.  
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To inactive a user, which will remove the user from the site, click the Inactivate button.  

 

If the Provider Portal user discovers that an email address has an error after it has been entered, the user can add 

the correct email address by clicking the Add User button, entering the required information, and then click the 

Save button. Then, the user will click the Inactive button for the email address which has the incorrect email 

address. For example, from the above Manage All Users screen, if the Business Administrator’s email address was 

incorrectly entered as oeldemonstation@gamaial.com, the process would be to click the Add User button and 

create oeldemonstration+3@gmail.com, click Save, and then click Inactivate for oeldemonstation@gamaial.com. It 

is important to create the correct email address first before inactivating the incorrect email address.  

Broadcast Messages 
The Broadcast Messages section of the Provider Dashboard will display all messages sent by the local early learning 

coalition to all providers in the coalition service area. Click the message title to see the full text of the message.  
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Coalition Messages 
The Coalition Messages section of the Provider Dashboard displays messages sent by the local early learning 

coalition to a specific provider. This is a one-way communication; the provider cannot email the coalition directly 

from the portal. Click the message title to see the full text of the message.  

 

Frequently Used Links 
The Frequently Used Links section of the Provider Dashboard has links to web pages with information about 

statewide provider requirements, training and services. 
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Completing the Provider Profile 
After registering as a provider, the next step is to complete the Provider Profile.  

Request Assistance 
If a Provider Portal user needs assistance filling out any information in the Provider Profile, click the Request 

Assistance button.  

 

  
 

Then, complete the field, briefly describing the need for assistance. Click the Submit button to send the request.  

 

 
 

After clicking Submit, the following message will display:  

 

 
 

 

 



 34 

The Provider Portal user will not be able to edit the profile once the request for assistance is submitted; however, 

coalition staff will be able to edit information in a profile while providing assistance to a Provider Portal user. 

 

The request for assistance can be cancelled by the Provider Portal user by clicking the Cancel Assistance Request 

button. 

 

. 

 

If a Provider Portal user cancels the assistance request, the following message will display and the user will 

complete the field, briefly describing the reason for cancelling the request. Click the Submit button to continue.  

 
 

After cancelling the request, the following message will display:  
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Business 
The Business Information page collects business information about the provider, including business name and 

address information, and it is shared among additional sites (if any). Only a Business Administrator may edit the 

information on this page.  

 

NOTE: This information was previously captured in the Business tab of the provider profile. Although the Business 

Information page is now separated from the provider profile, it must be completed before the profile may be 

submitted.  

Tool tips, indicated by the  symbol, are available to provide useful information to Provider Portal users about 

specific terms in the Provider Profile. Click the to see the message.  

To complete the Business Info page, click the Business dropdown menu from the Provider Dashboard.  

 
Then, click Business Info.  
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Profile 
A Provider Portal user must fill out all information in each tab, and click the Next button to continue filling out the 

provider profile information. Click the Back button to return to the previous tab. 

Tool tips, indicated by the  symbol, are available to provide useful information to Provider Portal users about 

specific terms in the Provider Profile. Click the to see the message.  

To complete the Provider Profile, click the Profile dropdown menu from the Provider Dashboard. 

 

Then, click Provider Profile.  
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Yellow Warning Symbols 
Yellow warning symbols will appear on certain fields on the following tabs: General, Facility, Services, Curriculum, 

Staffing & Capacity, and Documents.  

If the Provider Portal user hovers over the yellow warning symbol, the following message will display.  

 

If a change is made, the coalition will review the change and change the profile status to Incomplete to allow the 

Provider Portal user to re-submit the VPK-APP. The user will receive the following email from 

DONOTREPLY@OEL.myflorida.com.  
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Step 1 – General 
The General tab collects basic information about the provider, including provider types and whether or not there is 

interest in contracting with the early learning coalition to provide School Readiness or Voluntary Prekindergarten 

(VPK) Education services. 
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Step 2 – Facility 
The Facility tab collects contact information for the provider. The Provider Portal user is required to enter contact 

information for staff responsible for different aspects of the business. If the staff person is an Authorized Contract 

Representative or VPK Authorized Contract Representative, click the checkbox below each section (Director, VPK 

Director, etc.).  
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When the Add New Contact button is clicked, the Provider Portal user can create additional provider contacts for 

the profile.  
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Step 3 – Services 
The Services tab collects information on the ages of the children in provider care, as well as different provider 

services. 
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Step 4 – Curriculum 
The Curriculum tab collects information about the provider’s curriculum. A provider may choose multiple curricula 

from the list. If the provider is a school readiness provider, an approved curriculum must be chosen. If no approved 

curricula are being used by the provider, the Provider Portal user should select “Other.” If a provider does not see 

their curricula listed, choose “Other” as the curriculum. 

 

 

Step 5 – Fees & Discounts 
The Fees & Discounts tab collects information about fees the provider assesses the parent. The Provider Portal 

user should enter all applicable fees. All amount fields must have either a dollar amount or zero entered.  If a fee is 

not applicable, the amount entered must be “0.” If there are no family discounts offered, the selection must be 

“None.” 
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Step 6 – Hours of Operation 
The Hours of Operation tab collects information on the type of schedules offered for care. The Provider Portal user 

must click the checkbox next to the desired day of the week before inputting hours of operation for that day. The 

default hours of operation for each day are 6:00 a.m.– 6:00 p.m. An Enhanced Schedule is available.  
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Step 7 – Staffing & Capacity 
The Staffing & Capacity tab collects information on how many children the facility will or can care for. These 

questions are asked by age group. For each care level, the Provider Portal user should enter the highest number of 

teachers and children for all classrooms for each care level. This tab does not calculate staff-to-child ratios, but 

stores staffing and capacity numbers for local early learning coalition review.  

Staff-to-child Ratio is the number of children that an individual teacher is responsible for.  To reflect the actual 

ratio, the “Teachers in Classroom” column should always be 1.  For example, if you have 2 teachers with one class 

of 20, you should list 1 “Teacher in Classroom” with 10 “Children in Classroom” and a “Group Size” of 20.    If you 

follow the state mandated ratios for a center or facility, please see the example below.  You can omit the age 

groups you do not serve. 

Group Size is the maximum number of children, by age, that can be in a single classroom at any given time.  If you 

follow the state mandated group sizes for a center or facility, please see the example below.  You can omit the age 

groups you do not serve.   
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Example: Child Care Center 1 
This example uses the state mandated minimum staff-to-child ratios and maximum group sizes permitted for 

centers.  

 

Example: Child Care Center 2 
This example uses more stringent staff-to-child ratios and group sizes that are smaller than the state mandate for 

centers. 

 

For more information on staff-to-child ratios and group sizes for facilities, please visit the School Readiness Health 

and Safety Standards Handbook. 

http://www.floridaearlylearning.com/statewide-initiatives/health-safety/health-safety-checklists-handbooks-and-forms
http://www.floridaearlylearning.com/statewide-initiatives/health-safety/health-safety-checklists-handbooks-and-forms
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Example: Family Child Care Homes 1 
A family day care home is allowed to provide care for one of the following groups of children, which includes 

household children under 13 years of age.  Below are examples of how to fill out this table using the state 

mandated minimum ratios.  

**The group size column should never exceed 10 for a family child care home. 

This example uses the maximum of four children from birth to 12 months of age.  

 

Example: Family Child Care Homes 2 
This example uses the maximum of three children from birth to 12 months of age, and other children, for a 

maximum total of six children.  
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Example: Family Child Care Homes 3 
This example uses the maximum of six preschool children if all are older than 12 months of age. 

  

Example: Family Child Care Homes 4 
This example uses the maximum of 10 children if no more than 5 are preschool age and, of those 5, no more than 

2 are under 12 months of age. 

 

  



 50 

Example: Large Family Child Care Homes 1 
A large family child care home is allowed to provide care for one of the following groups of children, which 

includes household children under 13 years of age. 

**The group size column should never exceed 12 for a large family child care home. 

This example uses the maximum of 8 children from birth to 24 months of age. 

 

Example: Large Family Child Care Homes 2 
This example uses the maximum of 12 children, with no more than 4 children under 24 months of age. 

 

For more information on staff-to-child ratios and group sizes for family child care homes please visit the School 

Readiness Health and Safety Standards Handbook. 

 

http://www.floridaearlylearning.com/statewide-initiatives/health-safety/health-safety-checklists-handbooks-and-forms
http://www.floridaearlylearning.com/statewide-initiatives/health-safety/health-safety-checklists-handbooks-and-forms
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Step 8 – Private Pay Rates 
The Private Pay Rates tab collects information on the provider’s private pay rate based on unit of care and care 

level. The Provider Portal user must enter in the private pay rates for each “Unit of Care” and “Care Level” offered 

by the provider. Shaded cells do not permit entry. If care is not provided for that Unit of Care and Care Level, no 

entry is needed.  

Providers that indicate they want to complete a contract to participate in the school readiness program on the 

General tab will also have a section on the Private Pay Rates tab to enter the Daily Rates for the School Readiness 

Program. The Provider Portal user may edit the $0.00 amount for each “Unit of Care” and “Care Level” offered by 

the provider or click on the SR Daily Rate Helper button. The Helper button will automatically calculate the rates 

based on the Full Time Monthly Rates or Full Time Weekly Rates, and the Part Time Weekly Rates entered in the 

Private Pay Rates section. The rates are also editable after calculation. These rates will be utilized in the 

contracting process if the provider enters into a School Readiness contract with an early learning coalition.  

NOTE: With Release 3.5, School Readiness providers must now answer a question regarding the family’s 

responsibility to pay the differential between the Approved Reimbursement Rate and the Private Pay Rate.     
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Step 9 – Closures Calendar 
The Closures Calendar tab collects information on any days the provider will be closed. The Provider Portal user 

will select all closure days for the provider. Once selected, the date will change from white to blue. The local early 

learning coalition may define reimbursable holidays for the School Readiness program, which will be shaded gray. 

When a provider closure date and a coalition-defined reimbursable holiday are the same, the date will be shaded 

dark blue. A Provider Portal user does not need to include Saturdays and Sundays on the Closures Calendar if 

services are not provided on those days.   

NOTE: Actual reimbursable holidays will be selected during the contracting process if the provider enters into a 

School Readiness contract with an early learning coalition.  
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Step 10 – Documents 
The Documents tab allows the Provider Portal user to upload documents for the local early learning coalition to 

review. Based on provider answers in the provider profile, the Documents tab will display types of documents that 

may be uploaded to support a contract to provide School Readiness or VPK services. Users may enter up to five 

documents for each document type. Documents uploaded in this tab will also populate in the Document Library 

and will be utilized during the contracting process.  
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Step 11 – Review 
After reviewing the information for each section, the Provider Portal user must click the Next button to continue.  

 

 

… 
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     Step 12 – Sign and Certify 
To submit the Provider Profile, the Full Name must exactly match (and is case-sensitive) the name entered on the 

Manage Users page. The Provider Portal user must then check the “Check box to certify by electronic signature” 

check box and click the Submit button. 

 

 

Once the Provider Portal user submits the Provider Profile, the following page will display: 

 

The Provider Portal user should then find the email sent by DONOTREPLY@oel.myflorida.com. 
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Managing a Profile as a Provider Portal User 

Provider Dashboard 
On January 1 of each program year, a button will appear next to the current program year that will allow the 

Provider Portal user to migrate all profile information from the current program year to the next program year 

(except Closures Calendar dates). To migrate profile information to the next program year, the Provider Portal user 

will click the button. In this example, the provider is migrating profile information from the 2018 – 

2019 program year to the 2019 – 2020 program year. All information from the 2018-2019 profile will migrate to 

the 2019-2020 profile, with the exception of the Closures Calendar. The provider can also skip a profile year and 

still be able to create a profile for the current year. For example, the provider had a 2017-2018 profile, but skipped 

the 2018-2019 profile. In order to create a 2019-2020 profile, the provider will go to the 2017-2018 profile, click 

the Create 2018 button, then go to the 2018-2019 profile, and click the Create 2019 button. The skipped profile 

2018-2019 can remain Incomplete.  

 

 

After a provider is active, a Provider Portal User can edit the Provider Profile, by clicking the Profile dropdown 

menu and then clicking the Provider Profile button.  

 

Provider Portal users can manage School Readiness and VPK contracts from the Provider Dashboard.  
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Provider Portal users can manage School Readiness and VPK enrollments from the Provider Dashboard.  

                  

              

Provider Portal users can manage School Readiness and VPK attendance, as well as view reimbursement details for 

paid attendance rosters, from the Provider Dashboard.  

 

Provider Portal users can click the Documents dropdown menu to access the Document Library Management 

function and view and upload additional documents for coalition review.  
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Managing Contracts 
Provider Portal users can view contract statuses and edit/download contracts through the Manage Contracts 

function.  

 

Managing Documents 
Documents can be added to the Document Library for coalition review. The folder list within the Document Library 

is standard for all providers, but coalitions have the ability to re-name or add new folders. Documents uploaded to 

the Documents tab of the provider profile will also populate in the Document Library; however, documents 

uploaded to the Document Library will not populate in the Documents tab of the provider profile.  

To view or upload documents in a folder, the provider portal user will click the View Files or Upload New File 

button, respectively.  
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Provider Portal users can move within the Document Library by clicking the Change Folder dropdown menu. Files 

can also be renamed within each folder by clicking the Rename File button.  

 

Enter the new file name in the New File Name field and click the Save Changes button to continue.  
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A Frequently Asked Questions pop-up message is available for the Provider Portal user. Contact the local early 

learning coalition if additional help is needed.  
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Provider Contracting 
NOTE: Provider contracts are populated by information in the Active profile. As a result, the profile is read-only 

once the contract status is Initiated, Incomplete, or Submitted. If any changes need to be made to the Active 

profile after a contract is Initiated or there is an error found in the profile once the contract is being edited (the 

contract status is Incomplete), contact your early learning coalition.  

 

SR Contract 
After the coalition has initiated an SR contract, the Provider Portal user will click Manage Contracts from the 

Provider Dashboard.  

 

The following will display. Click the Edit button to edit the contract. 
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Provider Eligibility, Responsibilities and Scope of Work, Notification 
After clicking the Next Step button, the following will display. Review the options in the dropdown menus, and 

click Next Step to continue.  

 

  Quality Improvement Plan Selection 
After clicking the Next Step button, the following will display. Enter the user’s initials in each box below a check 

mark, and click Next Step to continue.  
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  Exhibit 4: Holiday Schedule 
After clicking the Next Step button, the following will display. The dates listed are based on the closure dates from 

the profile Closure Calendar tab and includes any coalition-defined holidays. Click Next Step to continue.  

 

 

NOTE: If fewer dates are listed than the coalition maximum total paid closure dates, additional provider holidays 

can be added to the holiday schedule exhibit, if applicable.  Click the Edit button on the holiday table. A pop-up 

appears with an editable holiday table. On a blank row, enter the holiday name, then select a date from the 

dropdown in the Date Observed column and click Save. Duplicate dates cannot be used. Click Next Step to 

continue. 

  Preview Contract 
Prior to executing the contract, click Preview Contract to view the contract. This allows the user to view all the 

information input into the contract from the profile, in addition to exhibits. Information from the above sections, 

added by the coalition when the contract is initiated, should be reviewed as well.  
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After clicking the Preview Contract button, the following will display.  

 

  Contract Execution 
After clicking the Next Step button, the following will display. To electronically sign the contract, check the By 

Electronic Signature checkbox.  

NOTE FOR PUBLIC SCHOOLS: If a school board or school district needs to manually sign a contract (instead of an 

electronic signature), the contract can be submitted without an electronic signature, then downloaded as a .pdf 

and printed. 
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After clicking the checkbox, the following message will display. Enter the Title of Signator and click Yes.  

NOTE: The Title of Signator is not the provider’s name, but the business title, e.g. Owner, Director, Principal.  

 

After clicking the Yes button, the electronic signature of the signatory and the date/time will populate in yellow. 

Click Next Step to continue.  

NOTE: The electronic signature and printed name of the Provider Portal user is based on the user who is logged on 

to the portal. Please ensure that the proper Provider Portal user is logged on to electronically sign the contract. If 

the incorrect name is used for the electronic signature, the checkbox can be un-checked. 
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  Contract Certification 
After clicking the Next Step button, the following will display. Enter the full name of the Provider Portal user who is 

logged on, title, and click the Certified by electronic signature checkbox. Click Submit.  

 

After clicking the Submit button, the following message will display and an email will be sent by 

DONOTREPLY@OEL.myflorida.com. 

 

 

 

The SR contract will have a status of Submitted.  
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VPK Contract 
After the coalition has initiated a VPK contract, the Provider Portal user will click Manage Contracts from the 

Provider Dashboard.  

 

The following will display. Click the Edit button to edit the contract. 

 

  Advance Pay Options 
After clicking the Edit button, the following will display. Review the Advance Payment Options in the dropdown 

menus, and click Next Step to continue.  
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Exhibit 1: Provider Location List 
After clicking the Next Step button, the following will display. Select the School Year and/or Summer checkboxes 

and click Next Step to continue.  

 

  Preview Contract 
Prior to executing the contract, click Preview Contract to view the contract. This allows the user to view all the 

information input into the contract from the profile, in addition to exhibits and attachments. Information from the 

above sections, added by the coalition when the contract is initiated, should be reviewed as well.  
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After clicking the Preview Contract button, the following will display.  
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Contract Execution 
After clicking the Next Step button, the following will display. To electronically sign the contract, click the By 

Electronic Signature checkbox.  

NOTE FOR PUBLIC SCHOOLS: If a school board or school district needs to manually sign a contract (instead of an 

electronic signature), the contract can be submitted without an electronic signature, then downloaded as a .pdf 

and printed. 

 

 

After clicking the checkbox, the following message will display. Enter the Title of Signator and click Yes.  

NOTE: The Title of Signator is not the provider’s name, but the business title, e.g. Owner, Director, Principal.  
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After clicking the Yes button, the electronic signature of the signatory and the date/time will populate in yellow. 

Click Next Step to continue.  

NOTE: The electronic signature and printed name of the Provider Portal user is based on the user who is logged on 

to the portal. Please ensure that the proper Provider Portal user is logged on to electronically sign the contract. If 

the incorrect name is used for the electronic signature, the checkbox can be un-checked. 
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  Contract Certification 
After clicking the Next Step button, the following will display. Enter the full name of the Provider Portal user who is 

logged on, title, and click the Certified by electronic signature checkbox. Click Submit.  

 

 

After clicking the Submit button, the following message will display and an email will be sent by 

DONOTREPLY@OEL.myflorida.com. 

 

 

 

The VPK contract will have a status of Submitted.  
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Amending Contracts 
Provider Portal users can amend contracts through the Manage Contracts function. Click the SR Contract 

Amendment or VPK Contract Amendment link, and the Provider Portal user will be re-directed to an OEL 

webpage. 

 

The Provider Portal user will click the applicable highlighted link to access a form-fillable .pdf amendment form to 

complete and submit to the early learning coalition.  
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VPK-APP 
The VPK-APP replaces forms OEL-VPK 10 (Provider Application), OEL-VPK 11A (Class Registration – Instructors), and 

OEL-VPK 11B (Class Registration – Calendars). The tabs must be done in order of appearance (Attendance Policy, 

then VPK Director, etc.); the answers in one tab populate information in the next tab.  

After the coalition has initiated the provider application, the Provider Portal user will click Manage Contracts from 

the Provider Dashboard.  

 

The following will display. Click the Edit button to review the contract. 

 

 

  Step 1 – Attendance Policy 
The Attendance Policy tab allows the Provider Portal user to upload the provider Attendance Policy. The document 

that is to be distributed to parents must be uploaded by clicking the Browse button, finding the document in the 

electronic files and clicking the Upload button.  
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Step 2 – VPK Director 
The VPK Director tab allows the Provider Portal user to add information and upload documents for the primary 

VPK Director that will be listed on the OEL-VPK 10. Click the Add New Director button to begin.  

 

Click the Save button after all information is entered for the director.  

 

NOTE: The Credential Type, Credential Certificate Number, Credential Issue Date, and Credential Expiration Date 

will not appear for public schools.   

Once the VPK Director is added, the supporting documents may be added by clicking Edit.  
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The Provider Portal user will select the document type, browse to select a file, enter the document issue or 

expiration date (if applicable), and click Upload. Then, click Save. At least one document should be uploaded.  

 

Step 3 – VPK Instructors 
The VPK Instructors tab allows the Provider Portal user to add information and upload documents for each 

instructor. Click the Add New Instructor button to begin.  

 

Click the Save button after all information is entered for each instructor.  
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Once the VPK Instructor is added, the supporting documents may be added by clicking Edit.  

 

The Provider Portal user will select the document type, browse to select a file, enter the document issue or 

expiration date (if applicable), and click Upload. Then, click Save. At least one document should be uploaded.  

 

 

Step 4 – VPK Calendars  
The VPK Calendars tab allows the Provider Portal user to provide information regarding each unique class calendar 

which will be offered at the VPK site. If classes are offered at identical times on identical dates, they utilize the 

same class calendar (e.g., all classes are scheduled from 8:00am to 11:00am, Monday through Friday, starting on 

January 11). If classes are not offered at identical times on identical dates, they utilize unique class calendars which 

must be created separately. Click the Add New Calendar button to begin.  

 

The Calendar ID will automatically populate with a letter beginning with A.  Each additional calendar will receive a 

sequential Calendar ID. 

The Calendar Name is an optional field.  It may be used for a short nickname such as “Fall AM.” 

The program type selection of School-Year (540 hours) or Summer (300 hours) is required.  The program selected 

will determine the valid calendar date range.  The Calendar Start Date and Calendar End Date must be within the 

valid calendar date range. The Calendar Start Date and Calendar End Dates should reflect the first day VPK 

instruction will be delivered and the final day VPK instruction will be delivered. 
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Next, the instructional days, start time and end time must be added by checking the box by the days of the week 

that VPK instruction will be delivered and entering the times of VPK instruction for the days of the week that VPK 

instruction will be delivered.  

 

After the instructional days, start time and end time are added, the Total Calculated Hours and Total VPK 

Instructional Days sections will populate. 

 

Providers are to use the calendar to note any non-instructional days on which VPK instruction will not be delivered 

(such as vacations or holidays) and exceptions to normal instructional days that occur during the defined calendar 

start and end date.  Entering Non-Instructional Days and Instructional Day Exceptions can increase or decrease the 

Total Calculated Hours.   

For example, if the Total Calculated Hours exceed 300 hours for the summer program type or 540 hours for the 

school-year program type (as shown in the example above), the user may remove a day (or more) by labeling it a 

Non-Instructional Day.  Each Non-Instructional Day entered will deduct the hours assigned to that day, thereby 

decreasing the Total Calculated Hours. Instructional Day Exceptions can be used to change the hours assigned to 

that day (to increase or decrease the hours).  For example, if the calendar is a few hours short, an instructional 

day’s hours may be extended to increase the Total Calculated Hours.  To add a Non-Instructional Day or an 

Instructional Day Exception to the calendar, click on that date on the calendar. Multiple days can be selected by 

clicking and dragging across multiple days on the calendar.  
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After clicking on a date, a pop-up message will appear.  The Provider Portal user must select the Event Type and 

enter a short description. When an Instructional Day Exception is selected, the user must also enter the time range 

for the day. 

 

Click the Update button to save changes. Click the Remove button to remove an existing Non-Instructional Day or 

Instructional Day Exception created on the calendar. 
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When the Total Calculated Hours match the hours for the VPK program type, the user will click the Save button.  

 

NOTE: The hours must equal, or be fewer than, 300 hours for the summer program type or 540 hours for the 

school-year program type for the calendar to save. 
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Step 5 – VPK Class(es) 
The VPK Class(es) tab allows the Provider Portal user to build VPK classes and assign instructor(s) to them. Click the 

Add New Class button to begin.  

 

The Class ID will automatically populate after the Class Calendar is selected.  The Class ID is created using a 

sequential letter beginning with A.  In the second space, either an “F” for school-year (fall) or “S” for summer will 

appear.  The F and S is derived from the calendar’s program type. The last two digits represent the last two 

numbers of the program year.  Each additional class will receive a sequential Class ID.   

The Class Name is an optional field.  It may be used for a short nickname such as “Blue Room.” 

The Main Curriculum drop down is populated with selections made from the provider’s profile. 

The Class Start Date and Class End Date are populated with the Calendar Start Date and End Date.  

The Instructors are populated with individuals from the VPK Instructors tab. Check the checkbox in front of the 

instructor to add them to the class, then enter the Instruction Start Date. If the class has not started yet, the 

Instruction Start Date defaults the Class Start Date. For each class, one Lead Instructor must be selected. Click the 

Save button after all information is entered for each class. 
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  Step 6 – Review  
During the review process, the Provider Portal user can click the Edit button to make any changes to a section. 

After reviewing the information for each section, the user must click the Certify and Submit tab button to 

continue.  
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Step 7 – Certify and Submit 
To submit the VPK-APP, the Signer’s Name must exactly match the name entered in the Provider Profile, the 

Provider Portal user must fill in the phone number, check the “Check box to certify by electronic signature” check 

box and click the Submit VPK Provider Application button.  
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Updating a VPK-APP 
A Provider Portal user can edit a VPK-APP by clicking the Edit button on their Manage Contracts page. Clicking the 

Download button will export the information in the VPK-APP to a .pdf document.  

 

VPK Director 
To edit the current director’s information in the VPK Director tab, click the Edit button. To remove a director, click 

the Remove button. To add a new director, click the Add New Director button. To edit the current supporting 

document, or add a new document, click the Edit button.  

 

When the Remove button is clicked, the following message will display.  

 

Once the director’s last day is entered and the Remove button is clicked, the director will no longer appear on the 

VPK Director screen, unless the Show removed directors checkbox is checked. The director can be re-added by 

clicking the Re-add button.  
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VPK Instructors 
To edit the current instructors’ information in the VPK Instructors tab, click the Edit button. To add a new 

instructor, click the Add New Instructor button. To remove an instructor, click the Remove button. To edit the 

current supporting document(s), or add a new document, click the Edit button.  

 

 

If the instructor has not been assigned to a class, when the Remove button is clicked, the following message will 

display.  
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Once the Remove button is clicked, the instructor will no longer appear on the VPK Instructors screen, unless the 

Show removed class instructors checkbox is checked. The instructor can be re-added by clicking the Re-add 

button.  

 

 

If the instructor has been assigned to a class, when the Remove button is clicked, the following message will 

display.  

 

To remove an instructor from a class, go to the VPK Class(es) section and click the Edit button for the class.  
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In the Instructors area, uncheck the instructor’s name. Once un-checked, enter the Last Taught Date, or click the 

Never began instruction of class checkbox if the class has not started. Click Save. 

 

The VPK Classes tab will now show that the instructor is removed from the class. 

Now that the instructor is no longer assigned to any class, the Provider Portal user may go to the VPK Instructors 

tab to remove the instructor by clicking Remove. The following message will display: 
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Once the Remove button is clicked, the instructor will no longer appear on the VPK Instructors screen, unless the 

Show removed class instructors checkbox is checked. The instructor can be re-added by clicking the Re-add 

button.  

 

The Review tab is also updated with the Instructor removal information. 
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VPK Calendars 
To edit the current calendar in the VPK Calendars tab, click the Edit button, make any necessary edits, and click the 

Save button. To remove a calendar, click the Remove button. To add a new calendar, click the Add New Calendar 

button. 

 

 

If there are no classes assigned to a calendar, when the Remove button is clicked, the following message will 

display.  

 
 

If there are classes assigned to a calendar, the following message will display: 
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Once a calendar is removed, the calendar will no longer appear on the VPK Calendars screen, unless the Show 

removed calendars checkbox is checked. The calendar can be re-added by clicking the Re-add button.  

 

 
 
NOTE: Calendar End Dates and Class End Dates are editable.  
 
The Calendar End Date can be changed to reflect changes in Non-Instructional Days or holidays that are added 
after the calendar begins. Changing the Calendar End Date will update the Class End Date and the Instructor Last 
Taught Date.  
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After the calendar is changed, if the provider needs to change the Instruction Start Date of an instructor, the 
provider will un-check and re-check the checkbox for each instructor and edit the date.  
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Also, the Calendar Name can be added if the provider did not add a Calendar Name when the calendar was 
created.  
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VPK Class(es) 
To edit the current class information in the VPK Class(es) tab, click the Edit button. To add a new class, click the 

Add New Class button. To remove a class, click the Remove button. After all edits have been made for each class, 

click the Save button.   

 

 

Classes that have started may not be removed. Limited editing is available. 
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If the class has not started, when the Remove button is clicked, the following message will display:  

 
Once the Remove button is clicked, the class will no longer appear on the VPK Class(es) screen, unless the Show 

removed classes checkbox is checked. 
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To end the class, click the Edit button and the change the Class End Date to reflect the last day that VPK instruction 
was provided. The Instructor Last Taught Date will be updated to the Class End Date after clicking the Save button. 
 

 
 

The Review tab will now reflect the updated class information. 
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Enrollments - VPK 
VPK Providers may manage VPK enrollment online by going to Enrollments> Manage VPK Enrollments.  Two 

options are available:  Request/Change Enrollment and Bulk File Upload.  

 
 

Request/Change Enrollment 
 
This feature allows VPK Providers to request or change enrollment for children in verified classes submitted 
through the VPK Provider Application.  To begin, select the VPK Program Year, VPK Session, and VPK Class.   
 

 
With the VPK Program Year, VPK Session, and VPK Class selected, the class start date and end date appear as well 
as the max class size.  This information is directly tied to the VPK Provider Application.  For example, if there is one 
lead instructor for the school-year session submitted and verified on the VPK Provider Application, the max class 
size will be 11; if there are two instructors for the school-year session submitted and verified on the VPK Provider 
Application, the max class size will be 20. 
 
Next, the VPK children count and Non-VPK children count are displayed.  These two counts (summed together) 
cannot exceed the max class size.  The Non-VPK children count is used to anonymously indicate private pay 
children participating in the VPK class.  The Non-VPK children count defaults to zero.  When the Non-VPK children 
count is used, the number of VPK children permitted in the class is reduced to maintain the max class size limit.   
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The class roster records are also displayed. If there are no children enrolled in the class, a “No records found for 
this class” message displays.  
  

 
 
If there are/were children enrolled in the class, the records are listed with the current enrollment status (Enrolled, 
Enrolled-Change Requested, or Enrollment Ended (Terminated)).  
 

 
 

Enrolling a VPK Child 
Using the child’s approved Certificate of Eligibility (COE) provided by the family, enter the Certificate Number, Child 
First Name, Child Last Name, and Child DOB.  Then, click Enroll to this Class.   
 
NOTE: The fields are not case sensitive; however, the certificate number must be entered exactly as it appears on 
the COE (i.e. VPK####-YYYY). 
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The system verifies that the information entered matches a child with an approved COE for the VPK program year 

selected and that the child is not already enrolled (or in a non-eligible status for enrollment).   

NOTE: The county on the COE does not have to match the provider’s county because the child has been deemed 

eligible to participate in the VPK program.  The enrollment process automatically updates the child’s county for 

service to the provider’s county so the corresponding early learning coalition may manage the child’s enrollment 

with the provider.   

When a matching child is found and validations checks are successful, a confirmation message appears.  To 

continue, click Yes. 

  

Next, the system asks for the Anticipated Start Date.  This is the date the child will begin attending class.  Typically, 

this is the class start date unless the child is starting after the class begins.   

NOTE: An anticipated start date cannot be before the class start date or after the class end date.  And, an 

anticipated start date cannot be before the child's COE issue date (as displayed on the child’s COE and listed in the 

enrollment window).  
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The system validates each enrollment request to make sure the max class size is not exceeded (based on the 

number of instructors assigned, the VPK session type, and current class enrollment count).  To continue, click 

Enroll Child.   

 

When the enrollment request is successful, the child appears on the class’s enrollment roster as “Enrollment 

Submitted" and the coalition receives the enrollment request for review/approval/rejection.  In addition, the 

family receives a notification that their child’s enrollment is in progress.   

 

While the enrollment request is being processed by the coalition, the status is updated on the enrollment roster.  

For example, the coalition has changed the status to Coalition Reviewing.  

 

If the coalition rejects or cancels the enrollment request, the child will no longer appear on the class roster.  The 

VPK Director and family will receive an email notification.  The family is instructed to download their child’s COE 

from the Family Portal and re-start the enrollment process.   
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When the enrollment process is approved by the coalition, the child’s status is Enrolled. 

 

Managing VPK Enrollment 
The class roster has several features for managing enrollment.  Providers may change the anticipated start date, 

request to move the child to another class, remove the child entirely from the roster because they never attended, 

or request a termination of services. 

  Change Anticipated Start Date 

To change the child’s anticipated state date, click Change within the Anticipated State Date column.  A window 

displays.  The current start date populates in the From field; enter the new start date in the To field.  This feature 

does not require coalition approval.  Click Save to commit the new date or click Close to abandon the date change 

and close the window.  This feature is available until the actual start date is recorded through the attendance 

process.  When the actual start date is populated in the column, the Change button is no longer available.   

 

Class Change 

Once the child's status is Enrolled, a class change may be requested.  To change the child’s class, click Class Change 

within the Actions column.  A window displays.  The current class populates in the From field; select the new class 

in the To field and enter the Transfer Effective Date.  The Transfer Effective Date should be the first day the child 

will attend the new class.  This feature requires coalition approval.  Click Submit Request to send the request to 

the coalition or click Close to abandon the class change and close the window.   
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Now that the class transfer request is submitted, the child appears on the roster for both classes.  In the From 

class, the child’s status is Enrolled.   

 
In the To class, the child’s status is Enrolled - Change Requested.  

 

When approved, the From class has a termination effective date (same as the transfer effective date).  If the 

termination effective date has not passed, the status is Enrolled.  When the termination effective date occurs, the 

status will be Enrollment Ended.  No further actions can be taken on this enrollment. 
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When approved, the To class is Enrolled with an anticipated start date and actual start date (same as the transfer 

effective date). 

 

NOTE: A class transfer request cannot be submitted for a child if the transfer effective date overlaps an existing 

enrollment period for that child. If the transfer effective date is BEFORE the termination effective date of the last 

enrollment, an error message appears, “The class transfer effective date overlaps an existing enrollment period for 

this child." 

When rejected, the request no longer appears in the To class.  The child remains enrolled in the From class. 

Class Change to a Full Class 

If a provider wants to move a child from class BF18 to class AF18, but class AF18 is full, the class change can still be 
done.  
 
Class BF18 is not full.  
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Class AF18 is full.  
 

 
 
The provider wants to move Blue Fairy Latham to AF18 from BF18.  
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The provider selects AF18 in the To field and enters the Transfer Effective Date. Once the Submit Request button is 
clicked, the provider receives a red message.  
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Now, the provider can either select a class that is not full, or select a child to swap with in the full class. Click the 
Submit Request button to complete the class change.  
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Never Attended 

To remove a child from a class completely because they never attended, click Never Attended within the Actions 

column.  A window displays.  This feature does not require coalition approval.  Click Yes to remove the child or click 

No to abandon the removal and close the window.  Removing an enrollment changes the record’s status to 

Enrollment Cancelled and the enrollment process starts over for the family.  The provider’s VPK Director will 

receive an email notification to inform them the enrollment is removed; no attendance or reimbursement may be 

sought.  The child’s record is no longer listed on the class enrollment roster or attendance roster in the Provider 

Portal.  The family will receive an email notification to inform them the enrollment for their child was cancelled; 

instructions are provided to log into the Family Portal to download the child’s COE and select another VPK 

provider. 

This feature is available until the actual start date is recorded through the attendance process.  When the actual 

start date is populated in the column, the Never Attended button is no longer available.   

   

NOTE: Be very careful with the Never Attended feature.  If the intention is to transfer the child to a different 

classroom, use the Class Change feature.  If the child attended class, VPK instructional hours were used, and 

reimbursement is needed, use the Terminate feature. 
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Terminate 

To terminate a child’s enrollment, click Terminate within the Termination Effective Date column.  A window 

displays.  Enter the last day that services will be/were rendered and select the reason for termination.  The 

Termination Effective Date is displayed below the Last Day of Services as one day after the last day of services.  

Therefore, the Termination Effective Date is the first day the child is NOT attending class.  This feature requires 

coalition approval.  Click Submit Request to send the request to the coalition or click Close to abandon the 

termination request and close the window.   

 

NOTE: A child’s enrollment cannot be terminated before the class start date. If the provider enters a date in the 

Last Day of Services that is BEFORE the class start date, an error message appears, “Termination effective date 

cannot be prior to the class start date. If the child never attended, click the Never Attended button to cancel the 

enrollment.” Either enter a termination date that is after the class start date (and on or after the COE issue date), 

or click Close to abandon the termination request and close the window. 

When the termination request is submitted, the child appears on the class’s enrollment roster as “Enrolled - 

Change Requested.”  The coalition will receive the termination request for review/approval/rejection.   

 

When the termination request is approved and the termination effective date has not passed, the status is 

Enrolled.  When the termination effective date occurs, the status will be Enrollment Ended.  No further actions can 

be taken on this enrollment. 
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When rejected, the child remains enrolled in the class. 

 

VPK Bulk Enrollment Process 
In addition to the enrollment method described in “Enrolling a VPK Child,” providers may submit enrollment 

requests to the coalition via a file process.  To begin, click the Bulk VPK Enrollment tab.  The bulk file processing 

page displays. 

 

Next, click on the link to download the CSV file template.  The file may appear at the bottom of the computer 

screen depending on the user’s browser.  

 

Open the file and expand the columns.  Each column is explained below. 
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A. Provider ID = this is the provider ID for the site displayed on the Provider Portal home page/dashboard. 

 

B. Certification Number = this is the child’s certificate number listed on their COE.  The field is not case 

sensitive, however, the certificate number must be entered exactly as it appears on the COE (i.e. 

VPK####-YYYY). 

 
C. Child First Name = this is the child’s first name listed on their COE.  The field is not case sensitive. 

 

D. Child Last Name = this is the child’s last name listed on their COE.  Do not include a suffix (if any). The field 

is not case sensitive. 

 

E. Child DOB (MM/DD/YYYY) = this is the child’s date of birth listed on their COE.  The field will accept 

M/D/YYYY as well. 

 

F. VPK Program Year = this is the child’s approved VPK program year listed on their COE.  The field is looking 

for the first 4-digit year only.  For example, if the VPK program year is 2017-2018, the entry would be 
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2017.  Generally, the 4-digit VPK program year matches the year included at the end of the child’s COE 

number.   

 

G. Class ID = this is the desired class’s 4-digit ID.  The class ID must be entered as the 4-digit assigned ID.  Do 

not include the class name (if any).  Looking at the example below, the entry would be “AS17” not 

“Songbirds” or “AS17-Songbirds.” 

 
 

 

H. Anticipated Start Date (MM/DD/YYYY) = this is the date the child will begin attending class.  Typically, 

this is the class start date unless the child is starting after the class begins.   

NOTE: An anticipated start date cannot be before the class start date or after the class end date.  And, an 

anticipated start date cannot be before the child's COE issue date. The field will accept M/D/YYYY as well. 

 

I. MSID (XX-XXXX) = this field is for public schools only.  Public schools may enter their Master School 

Identification (MSID) number in a 6-digit format, where the first 2 digits are the district number followed 

by a hyphen and 4-digit school number.  The MSID number can be used in lieu of the Provider ID in 

column A.  Both IDs are accepted. 

When the file is complete, name it and save it as a CSV file type.   

NOTE: It may be helpful to include your provider name and class in the file name if troubleshooting is ever 

necessary. 
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When changing the file format to CSV, Excel often displays a message to ask if you want to keep using that format.  

If this message appears, click Yes. 

 

Click the Upload button.  A window displays.  Select your file and click Open.  

 

The file upload will begin.  The file details will populate on a row and turn green.  Click the Refresh button to 

populate the results. 

 

The file details will be updated.  The file size, total records count, committed records count, failed records count, 

processed time, status, and final results are updated.  The file results are also returned and can be downloaded by 

clicking on the Download button.   
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In this example, there is one failed record and three committed records.  The file download will include the error 

message and status for each record submitted.  The three committed records are now “Enrollment Submitted” and 

the failed record was not included because of an invalid date of birth.  The same validations that occur with a 

manual child enrollment occur with the bulk enrollment file process.  

 

The three committed records are displayed on the class’s enrollment roster as “Enrollment Submitted" and the 

coalition receives the enrollment requests for review/approval/rejection.  In addition, the family receives a 

notification that their child’s enrollment is in progress.  The same processes that occur with a manual child 

enrollment occur with the bulk enrollment file process.  

 

NOTE: When correcting records and re-uploading the file, be sure to remove the “Error or Status” column as it is 

not accepted for the upload.  Also, it is best to NOT include records that have already been submitted successfully 

as they will now error as having been processed.  When removing successful records and the Error or Status 

column, it is best to highlight the row/column and use the cut/delete option instead of just deleting the 

information.  Excel often retains formats even if the cells are now empty. 
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Enrollments - SR 
See EFS Modernization Project User Guide for more information.  
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Attendance - VPK 
Providers manage VPK attendance online by navigating to the Attendance menu item and selecting Manage VPK 

Attendance.  Providers may submit their attendance through the web page or using a bulk file upload, similar to 

the bulk enrollment file upload.  It is important to note that changes to enrollment, such as entering a termination 

date, or changes to the class schedule, such as reporting a site closure, cannot be performed in attendance.  

Enrollment information must be corrected in the Enrollments area.  Class schedule information must be corrected 

in the Contracts> VPK Provider Application area.  Any changes to source data should be done prior to submitting 

attendance.  Coalitions may assist as needed. 

 

Submitting Attendance Online 
Select the Manage VPK Attendance menu item.  The VPK Attendance Roster displays, defaulting to the current 

service period and first class.  The blue summary box to the right contains class details such as the class full name, 

start and end dates, and max class size.  If necessary, use the drop downs to select a different service period 

and/or class.   

 

NOTE: A service period is the month in which services were rendered.  Child absences for the service period must 

be marked, saved, and submitted to the coalition for payment.  A due date is displayed for each service period.  

Providers with multiple classes must submit an attendance roster for each class for payment.   

The search feature may be used to search for any criteria included in the roster (i.e. a name, DOB, age, billing 

group, or status).  The summary feature shows the current/saved attendance information for all children in one 

view. 
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To record attendance, click on a child’s name to view their attendance for the month.   

 

 Days the site is closed are marked with an asterisk “*.” 

 Days the child is scheduled to attend are marked with an “X” for present.   

 A legend is provided in the bottom right for more code descriptions.  

To change a present day to absent, click on the “X.”  The “X” for present will now appear as an “A” for absent.   

NOTE: Absences entered by mistake can be changed back to present by clicking on the “A.”   

While not required, it is recommended to click Save (below the calendar) before moving on to another child.  

When all child absences are marked for the month, click Save and then click the Submit to Coalition button.  A 

window may appear if the attendance is being submitted early or late, or if no absences have been recorded.  To 

continue to the Sign & Certify page, click Continue. 
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The Sign and Certify page displays the class summary with the total number of days absent and days present.  At 

this point, providers may want to print this page using the browser print function.  When ready, review the 

certification statements and complete the Authorized Electronic Signature portion by entering the user's Full 

Name, checking the box for Certify by electronic signature, and clicking Submit.  To abandon the submission, click 

Cancel.  

 

Submitted Attendance 
Upon submission, the screen returns to the VPK Attendance Roster view with the current service period displayed.  

Select the submitted service period from the drop down.  The submitted roster now has a submitted message and 

each child shows “SUB” for submitted in the status column.  This status will change as the child attendance is 

processed by the coalition. 
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Rejected Attendance 
Coalition staff may reject submitted attendance.  In this case, the individual that submitted the roster will receive 
an email notification.  Instructions are provided to log in to the Provider Services Portal, review the roster, make 
necessary changes to rejected records, and re-submit.  The rejected child records are displayed at the top of the 
roster list in red and show "REJ" for rejected in the status column.  Only records with "REJ" may be edited. 

 
 
To edit, click the name of a rejected record.  Any absences previously recorded appear.  Make changes as needed.  
After the last record is corrected, click Save.  Then, click the Submit to Coalition button and continue to the Sign & 
Certify page.  This time, the Sign & Certify page only shows the rejected records that are being re-submitted to the 
coalition.  Complete the Authorized Electronic Signature portion and click Submit. 
 

 
 
Upon submission, the rejected "REJ" records appear on the roster as submitted "SUB."   
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Approved Attendance 
Coalition staff will continue to work submitted attendance until the records are approved for payment.  Approved 
records appear on the attendance roster as "APP" for approved in the status column.   

 
 
When records are paid by the coalition, the reimbursement details are posted on the Provider Portal under 
Attendance> Reimbursement Details. 

 
 

Uploading Bulk Attendance File 
Providers may submit their attendance via a bulk file upload (similar to the enrollment bulk file upload process).  

To begin, go to the Attendance menu item, choose Manage VPK Attendance, and then select Bulk File Upload. 

 

The Bulk VPK Attendance page displays. 

 

Click the CSV file template link.  A window appears.  From this window, select the service month and year to 

generate a file for all of the enrollments (for all classes) at the site that month.  Alternatively, multi-site providers 

may check the "Include all providers for provider principal" box to generate a file for all of the enrollments (for all 

classes) at all sites associated to the account for that month.  Then, click the Download button. 
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Open the downloaded file.  The enrollment information for each class is pre-populated.  Each instructional day 

during the student's enrollment defaults to present (X). 

 

 

a. Legend:  present (X), site closed (*), student not started (_), student terminated (T).  

b. Day_1 = first of attendance month, Day_2 = second day of attendance month, Day_3 = third day 

of attendance month, etc.  In this example, Day_1 = August 1, Day_2 = August 2, and Day_3 = 

August 3. 

c. Regardless of the month/year, columns for Day_1 to Day_31 are included in the file and are 

necessary for the upload; none should be removed. 

d. It is critical that only the content of "Day_#" columns are changed (i.e. changing an X to an A).  

Attempting to add students or edit/remove system generated columns will cause errors.  The file 

is a reflection of the enrollment information for the class when downloaded.  If issues are 

identified, please contact the local early learning coalition for assistance. 

Scroll over to the days and record absences by changing a present day (X) to absent (A).  Tip: (In Excel) Open the 

View menu, select column H, and click Freeze Panes.  This will keep the student's name and demographic 

information in view while scrolling through days.   
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(In Excel) When complete, un-hide and/or un-freeze any columns.  Click File> Save As.  Re-name file and save 

locally.  Be sure the file type is .csv. 

 

On the Provider Portal, click the Upload button.  A file manager window opens.  Locate the saved file and click 

Open. 

 

The uploaded file displays in the Bulk VPK Attendance log. 

 

Click the Refresh button to get final results. 

 

The successfully submitted attendance is now reflected on the class attendance roster.  Each record shows "SUB" 

for submitted.   
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Attendance - SR 
Providers manage SR attendance online by navigating to the Attendance menu item and selecting Manage SR 

Attendance.  Providers may submit their attendance through the web page.  It is important to note that changes to 

enrollment, such as entering a termination date, cannot be performed in the attendance module but rather the 

Manage SR Enrollment area.  Also, when issues appear on the attendance roster (such as incorrect enrollment 

information, missing children, duplicate children, missing paid holidays, duplicate absences on the same day, etc.), 

the issues should be communicated to the coalition before submitting the attendance roster.  Coalitions may assist 

in addressing the issues so that the attendance records have accurate information.   

 

Submitting Attendance Online 
Select the Manage SR Attendance menu item.  The SR Attendance Roster displays, defaulting to the current 

service period.  The blue summary box to the right contains provider details and paid holiday information for the 

service period.     

 

NOTE: A service period is the month in which services were rendered.  Child absences for the service period must 

be marked, saved, and submitted to the coalition.  A due date is displayed for each service period.  Providers that 

contract with multiple coalitions must submit an attendance roster to each coalition.   

Children that are “Enrolled” or “Pending Parent Acceptance” are included on the SR attendance roster.  Children 

that are “Pending Parent Acceptance” are listed first and have an initial status of “PND”; children that are 

“Enrolled” do not have an initial status.  When “PND” children are listed, a provider message will also appear.  

Clicking OK dismisses the message. 
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The search feature may be used to search for any criteria included in the roster (i.e. a name, DOB, age, billing 

group, or status).  The summary feature shows the current/saved attendance information for all children in one 

view. 

To record attendance, click on a child’s name to view their attendance for the month.   

 

 Days the site is closed are marked with an asterisk “*.” 

 Days the child is not scheduled to attend are marked with “NS.” 

 Days the child is scheduled to attend are marked with an “X” for present along with his/her 

scheduled unit of care.   

 Paid holidays where a child is also scheduled to attend are marked with an “H.”  

 A legend is provided in the bottom right for more code descriptions.  

NOTE: The “Child’s Current Information” displayed on the right is current as of today.  When working prior months, 

the information displayed may not align.  For example, if a child’s enrollment was terminated in February 2019, the 

current enrollment status is Enrollment Ended.  Each month (prior to February) will also display Enrollment Ended 

in the “Child’s Current Information” area because it is the current enrollment status.  This does not impact the 

ability to record attendance for those prior months.  Enhancements are planned to address the display.   

To change a present day to absent, click on the “X.”  A pop-up message appears to collect more information. 

a. Select an absent reason from the dropdown.      

b. Include a message to the coalition regarding the absence in the Note area.  (optional for most reasons) 

c. Attach a file for supporting documentation by clicking Choose File.  (optional) 

d. Click Save when done and the pop-up message will close. 

e. The “X” for present will now appear as an “A” for absent.  

f. NOTE: Consecutive absences must be entered per day (i.e. there isn’t a click and drag feature to select 

multiple days at once).  However, it is not necessary to upload the same document per day when it 

applies to multiple days.  Upload the document on one of the absences and reference it in the Note area 

for the other absences.   
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g. Absences entered by mistake can be changed back to present by clicking on the “A.”  A message will 

appear to confirm the change.  Clicking Yes removes the saved absence information, deletes the 

document, and changes the “A” for absent to “X” for present. 

While not required, it is recommended to click Save (below the calendar) before moving on to another child.  

When all child absences are marked for the month, click Save and then click the Submit to Coalition button.  A 

window may appear if the attendance is being submitted early or late, or if no absences have been recorded.  To 

continue to the Sign & Certify page, click Continue. 

 



 125 

The Sign and Certify page summarizes the information for each child and an electronic signature is required.  

 

Submitted Attendance 
Upon submission, the screen returns to the SR Attendance Roster view with the current service period displayed.  

Select the submitted service period from the drop down.  The submitted roster now has a submitted message and 

each child shows “SUB” for submitted in the status column.  This status will change as the child attendance is 

processed by the coalition. 
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Rejected Attendance 
Coalition staff may reject submitted attendance.  In this case, the individual that submitted the roster will receive 
an email notification.  Instructions are provided to log in to the Provider Services Portal, review the roster, make 
necessary changes to rejected records, and re-submit.  The rejected child records are displayed at the top of the 
roster list in red and show "REJ" for rejected in the status column.  Only records with "REJ" may be edited. 

 
 
To edit, click the name of a rejected record.  Any absences previously recorded appear.  Make changes as needed.  
After the last record is corrected, click Save.  Then, click the Submit to Coalition button and continue to the Sign & 
Certify page.  This time, the Sign & Certify page only shows the rejected records that are being re-submitted to the 
coalition.  Complete the Authorized Electronic Signature portion and click Submit. 
 

 
 
Upon submission, the rejected "REJ" records appear on the roster as submitted "SUB."   
 

  



 127 

Approved Attendance 
Coalition staff will continue to work submitted attendance until the records are approved for payment.  Approved 
records appear on the attendance roster as "APP" for approved in the status column.   
 

 
 
When records are paid by the coalition, the reimbursement details are posted on the Provider Portal under 
Attendance> Reimbursement Details. 
 

 
 

 

  



 128 

Logging on to the Coalition Services Portal  

The Coalition Services Portal allows coalition users to manage all registrations and profiles submitted through the 

Provider Portal. Coalition admins will also be able to manage coalition user accounts and run ad hoc reports from 

the Coalition Services Portal. 

Coalition users can access the Coalition Services Portal at https://coalitionservices.floridaearlylearning.com. 

 

 

Creating a New Coalition Services Portal Account 
To access the Coalition Services Portal, the coalition user must first register an account. To get started, click the 

register link.   

 

https://coalitionservices.floridaearlylearning.com/
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The Access user name (email address) and Access password must be obtained by the Coalition Services Portal 

administrator. 

The coalition user must fill in all fields and click the Continue button to submit a request for approval to create an 

account.  

NOTE: It is important for the coalition user to select the correct Coalition Name to enable the coalition admin to 

find the correct account to activate.  

 

The coalition user must wait until the coalition admin activates the account before the user can log on. 
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Update Coalition Portal User Account Information 
Coalition users are able to update their user information – name and phone number – associated with their email 

address.   

Click on the gear icon. 

 

The following will display. Click the Account Information button.  

 

 

Enter the additional information and click Save.  
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Once the coalition user successfully logs on, the following page will display: 

 

Coalition Services Portal User Types: 

 Coalition User – Able to search profiles and process account registrations and profiles in the service 

area. A Coalition Admin can set specific permissions for a user to customize the user’s access.  

 Coalition Admin – Able to search profiles, process account registrations and profiles, run ad hoc 

reports and manage coalition users in the service area. 

 OEL User – Able to search, view profiles and run ad hoc reports for all counties. 

 OEL Admin – Full access. 

Coalition Services Portal Main Page Navigation 
The Navigation Bar can be found near the top of the page. 

Home Button 
The Home button will take the coalition user to the Coalition Services Portal main page. 
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Provider Menu 
Clicking the Provider menu will activate the dropdown menu.  

Provider Profiles 
Clicking Provider Profiles will display all possible provider profile statuses.  

 

 

Click on a status to see all provider profiles with that status.   
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Contracts  
The Contracts function allows a coalition admin to view a list of provider contracts in the local early learning 

coalition service area – VPK, SR, VPK-APP, VPK/SIS, and local. 

Provider Search 
The Search function allows a coalition user to quickly search for provider profiles.  

NOTE: To ensure accurate searches, click the dropdown menu when changing search terms (business name, 

provider ID, etc.) or starting a new search. Do not use the Back button on the internet browser.  

 

Coalition users can also search for providers outside of their coalition service area (select All coalitions radio 

button) and will have read-only access to that provider profile. A provider may want to contract with multiple 

coalitions, so before the contract is certified, a coalition can have read-only access to that potential provider’s 

profile.  
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After the coalition user clicks the Search button, the following will display. To view the Administrative Review 

screen of the provider profile, the user will click the Profile ID link of the desired record.  

 

To view the Manage Users screen, which displays the user roles for the provider, the user will click the Provider ID 

link of the desired record.  

 

The following will display. Click the Manage Users button to view the users.  
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Provider User Roles: 

 Business Administrator – Able to edit the provider profile and principal business information that is 

shared among associated provider sites; able to add provider sites and users; submit profiles and 

profile updates; and create contracts. This role would typically be assigned to an owner.  

 Site Administrator – Able to edit the provider profile associated to their site add provider users for a 

site, but cannot create a new site. This role would typically be assigned to a principal or director.  

 User – Able to perform administrative tasks based on permissions granted by the Business 

Administrator or Site Administrator. This role would typically be assigned to teachers and aides.   

Document Library Management 
The Document Library Management function allows a coalition user to review documents uploaded to the provider 

profile.  

Admin Functions Menu 
Admins will be able to do the following functions for providers: 

 Account Management – Manage accounts for coalition staff and providers within the coalition 

service area. 

 Messaging management – Send messages to individual providers, providers based on services 

(SR, VPK, CCR&R) or all providers in the coalition service area.  

 Rates management – Manage SR and VPK rates.  

 Holiday schedule – Set reimbursable closure days for providers within the coalition service area.  

NOTE: Only coalition admin or OEL admin users will be able to view and access the Admin Functions menu. 
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Reports Menu 
Clicking the Reports menu will display the list of available reports.  

NOTE: Only coalition admin or OEL admin users will be able to view and access the Reports menu. 
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The Provider Status Tracking Adhoc Report generates a report that displays profile, contract, and principal 

information for providers in a coalition’s service area.  
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Activating a Provider Account 
Use this page to approve pending provider registration requests and create the corresponding businesses and 

sites.  

To view, approve or reject a provider registration request, click on the corresponding entry in the table below to 

show the full details of the request. 

 

When a provider account is activated, an email will be sent by DONOTREPLY@OEL.myflorida.com. 

 

Provider Profile Status Definitions 

Incomplete 
The profile is not complete. The provider has to complete the required fields, certify, sign and submit the 

profile.  

Coalitions cannot change the status of an Incomplete profile; however, coalition users have read-only 

access to assist the provider in completing the profile. 

Request Assistance 
The provider needs help to finish or edit the profile.  
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Submitted 
The profile has been completed and submitted by the provider for coalition review. The profile is not 

editable by the provider while in Submitted status. 

Coalition Reviewing 
To review a Submitted profile, click the Change Profile Status button at the top of the Administrative 

Review page.   

Active  
The coalition has reviewed the profile and supporting document(s) and determined that the provider is 

eligible to receive funding. 

Inactive 
The profile is no longer active or is no longer receiving funding.  

Rejected 
The profile is missing information that is necessary to make a decision regarding eligibility to receive 

funding.  

Rejected status is used to return the profile to the provider for edits. 

Coalition User Task Bar 
At the top of the Administrative Review page is a list of buttons used to maintain and process a Provider Profile. 

 

 
Click to view or add a case note. 

 
Click to log a provider contact attempt. 

 
Click to view or upload inspections. 

 
Click to update provider information. 

 
Click to manage contracts.  

 
Click to manage contracted SR provider's paid holidays. 

 
Click to manage contracted SR provider's reimbursement rates. 

 
Click to change the status of a profile. 

 

Adding a Provider Note 
The coalition user must click the Provider Notes button to add a Provider Note.   

Then, click the +Add Provider Note button.   
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The coalition user will then select a Provider Note Code and complete the note field. Click the Save Note button to 

add the note.  

 

Click the Return to review button to go back to the Administrative Review page.  

 

Adding a Contact Attempt 
The coalition user must click the Contact Attempts button to add a Provider Notification.   

Then, click the +Add Provider Notification button.   

 

The coalition user will complete the Date and Subject fields, select which Method(s) of Contact were used, and 

complete the Note and Outcome fields. Click the Save button to add the notification.  

NOTE: A contact attempt does not create a provider note.  
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Click the Return to review button to go back to the Administrative Review page.  

 

Adding an Inspection 
The coalition user must click the Inspections button to add a Provider Inspection.   

Then, click the +Add Provider Inspection button.   
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The coalition user will complete the Date field, select the inspection result, and complete the Note field. Click the 

Save button to add the inspection.  

 

Click the Return to review button to go back to the Administrative Review page.  

 

Adding Administrative Information 
The coalition user must click the Administration button to update administrative information. This feature is only 

available in Coalition Reviewing status.  

 

The coalition user will complete the SUNBIZ Document Number. Other editable information will be added in the 

future. Click the Save button to add the number.  
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Adding SR Paid Holidays 
Once an SR contract is certified, the provider's paid holidays must be set up.  On the Administrative Review menu, 

click the SR Paid Holidays button.  The provider's SR Paid Holidays for the profile year displays. 

 

The page may pre-populate with days if they are available from the online SR contract or Coalition SR Holiday 

Schedule (established on the Admin> Calendar Management> SR Holiday Schedule page).  While this information 

may be pre-populated for convenience, the remaining steps should be followed to ensure the correct paid holidays 

are recorded.   

To add a new paid holiday, click the Add Paid Holiday button. 

 

Enter the Holiday Date and Holiday Name.  Then, click the Save button. 

 

Days that have occurred in the past cannot be updated or removed.  To update a paid holiday, click the Update 

button.  The saved holiday displays and may be edited.  When complete, click Save.   
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The holiday information reflects the updated information.   

 

To remove a paid holiday, click the Remove button.  The holiday information is removed from the list. 

Adding SR Reimbursement Rates 
Once an SR contract is certified, the provider's reimbursement rates must be set up.  On the Administrative Review 

menu, click the SR Reimbursement Rates button.  The provider's SR Reimbursement Rate plan(s) display. 

To establish a new rate plan, click on the Add Reimbursement Rates button.  
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The rate plan settings page appears.  Enter the Reimbursement Start Date and Reimbursement End Date.  Click 

Save.   

NOTE: If multiple rate plans are needed to address a rate change, continue to set up the first rate plan for the 

original start and end dates.  Then, additional rate plans can be created as shown in Amending SR Reimbursement 

Rates (by adding another rate plan). 

 

The provider’s reimbursement rate plan page appears.  Rate plans cannot overlap. If a rate plan is entered that 

overlaps, then a validation message displays. Clicking the Yes button will change the rate plan to prevent 

overlapping dates. Clicking the No button will discard the rate plan change. 

 

 

Click Reimbursement Rates.  
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The provider’s rates for the rate plan appears.   

2019-2020 Reimbursement Rate Plans 
A note displays at the top of the Rate Plan – “* Reimbursable rate is reduced because the amount exceeds the 

provider’s private pay rate upper limit set in Column F.” Any rates marked by a *, show the provider is near the 

upper limit (Column F) with the differential, and the amount shown is what the provider will reimbursed.  

NOTE: The rate plans for 2019-2020 allow the provider to exceed the private pay rate. For 2019-2020, the Provider 

cannot exceed Column F – 20% above the private pay rate. 

 

 Column A = displays amounts from the provider's contract for private pay rates (captured at the time of 

contract initiation from the provider's profile).   

 Column B = displays amounts from the Coalition's SR Plan Rates (established on the Admin Functions> 

Rates Management> SR Plan Rates page).   

 Column C = displays the approved provider reimbursement rate without Gold Seal (the lower of column A 

or B). 

 Column D = displays the Gold Seal differential (column C x the percentage established on the Admin 

Functions> Rates Management> SR Plan Rates page). 

 Column E = displays the approved provider reimbursement rate with Gold Seal (column C + D; amount 

cannot exceed column F; Gold Seal participation is established on the Edit Differentials tab). 

 Column F = displays the provider's private pay rate upper limit (column A x 20%) 

 Column G = displays the QPI differential rate (column C x tier percentage; QPI participation is established 

on the Edit Differentials tab). 

 Column H = displays the Local QI differential rate (column C x tier percentage; QI participation is 

established on the Edit Differentials tab). 

 Column I = displays the total payment to provider (column E + G + H; cannot exceed column F). 

 Column J = displays the total contracted slot differential rate available to selected children (Contracted 

Slots participation is established on the Edit Differentials tab). 
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 Column K = child assessment differential rate (column C x tier percentage; child assessment participation 

is established on the Edit Differentials tab). 

Hovering over a rate marked with a *, displays the calculated amount prior to reaching the upper limit (Column F). 

The rate shown with a *, is the amount the provider will be reimbursed.  

 

While some information may be pre-populated for convenience, the remaining steps should be followed to ensure 

the correct provider reimbursement rates are recorded.   

Edit Provider Rate 

Click the Edit Provider Rates button.  The private pay rates page displays.  Review and/or enter the provider's 

private pay rates (column A) for the established rate plan date range and click Save.   

NOTE: Rates may be edited on or before the rate plan start date, after which they cannot be edited unless 

payment has not been issued yet.  At that point, a new rate plan must be created. 
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Edit Differentials 

Next, click the Edit Differential Rates button.   

 

The differential rates page displays.  Review and/or edit the differential rate settings (columns E, G, H, I, and K) for 

the established rate plan date range and click Save.  Differential rates are turned on by selecting the Yes radio 

button and the tier level.   

NOTE: The Effective Date and End Date match the established rate plan and cannot be changed.  If a differential 

applies to a length of time other than the established rate plan, an additional plan must be created.  See Amending 

SR Reimbursement Rates (by adding another rate plan).  Providers participating in contracted slots require the total 

number of slots to be selected and rate amounts entered.  (Children receiving a contracted slot must be identified 

within the SR Program> SR Provider Enrollment> Enrolled work queue.)  See Contracted Slots. 
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Amending SR Reimbursement Rates (by adding another rate plan) 
Open the provider’s admin page from their profile.  Click the SR Reimbursement Rates button.  The provider’s 

reimbursement rate plan page appears.  Click on the Add Reimbursement Rates button. 

 

The rate plan settings page appears.  Enter the first day that the new rate plan is effective for the Reimbursement 

Start Date, then Enter the Reimbursement End Date and click Save. 

 

Now, a new rate plan appears.  The existing rate plan’s Reimbursement End Date is changed by the system to end 

a day prior to the new rate plan’s Reimbursement Start Date.  Click on the Reimbursement Rates button for the 

new rate plan and proceed to review/modify the Provider Rates and Differential Rates accordingly.   
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  Contracted Slots 

Setting Up a Provider with Contracted Slots 

Using the provider’s SR Reimbursement rates from their profile (Private Pay Rates tab, bottom section), click the 

Edit Differentials button. Turn on the Contracted Slots differential rates by selecting the Yes radio button, then 

click Save.  

Providers participating in contracted slots require the total number of slots to be filled in and rate amounts 

entered for each level of care.  

 

Enrolling a Child in a Contracted Slot 

The child has to have an active SR enrollment with the provider.  If the enrollment has been terminated, the child 

will not be able to be enrolled in a contracted slot. 

The children receiving a contracted slot must be identified within the SR Program> SR Provider Enrollment> 

Enrolled work queue.  Search by provider name.  The number of contracted slots the provider has is displayed.  
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Providers that do not have contracted slots will not have the checkboxes to select a child for contracted slots 

enrollments. 

 

Providers that have contracted slots will have checkboxes to select a child for contracted slots enrollments, and 

the number of available contracted slots is displayed. 

 

 

The child’s name, age, unit of care, level of care, billing group and enrollment dates are displayed.  

Click on a contracted slots checkbox.  A pop-up displays to enter the contracted slots enrollment dates.   

 

By checking the contracted slots checkbox, the Start and End date fields become required. The contracted slots 

dates do not have to coincide with the child exact enrollment dates, but the contracted slot start date cannot be 

prior to the SR enrollment Start Date. The Contracted Slot End date cannot be more than 60 days after the SR 

enrollment End Date. The contracted slots dates have to be within the provider's contracted slot agreement 

effective dates.  
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The provider is not allowed to select more than the amount of slots they have are contracted to have. If the 

provider has 10 slots in their contract, the coalition user can only fill 10 slots. Each time a slot is filled, the available 

slots decrease. 

 
 

The termination date for the Contracted Slots enrollment can be postponed for up to 60 consecutive calendar days 

if a child ages out when school starts, leaves the program, or has a schedule change that is no longer Full-Time (FT).   

Clicking a checked contracted checkbox displays the Update or End question. 

 

Selecting End will populate the current date, then click Save.  

Selecting Update will require a new end date. The end date cannot be greater than 60 days after the SR enrollment 

end date. The new end date must be within the current billing period and cannot be in a previous month.  
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The provider will not see any indication of contracted slots enrollment on their enrollment and attendance roster. 

The coalition will see the child’s contracted slot enrollment and rate in the provider’s Closed Attendance, 

Reimbursement Record. 
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Processing a Provider Portal Profile 
From the Home screen, the coalition user will click the Provider menu.  

 

Then, the coalition user will click the Provider Profiles and select Submitted work queue to review a list of all 

submitted profile requests. Coalition staff may click the provider ID link to open a profile.    

 

Request Assistance 
Providers may request assistance from coalitions by using the Request Assistance feature.  When selected by the 

provider, requests appear in the Request Assistance work queue.  Coalition staff may click the provider ID link to 

open a profile.  Once a profile is open, coalition staff may review the Provider Notes to locate information 

regarding the reason for the request.   

 

Next, coalition staff may select the Cancel Assist button or Assist Provider button.  

  

The Cancel Assist button will cancel the request and the provider will again be able to edit the profile. The profile 

status returns to its prior status. 

The Assist Provider button places the profile in a status that allows coalition users to edit the profile.  After clicking 

the Assist Provider button, the profile status will change to Assistance Accepted.   
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Once the coalition user has finished editing the provider profile, click the Assistance Complete button.  

 

Then, the coalition user will fill in the Comments section of the Assistance Request Completed pop-up and click 

Submit.   

 

If a provider needs help uploading a document, and the coalition has an electronic copy of the document, the 

provider may use the Need Assistance function to allow the coalition to upload the document.  

Provider Notes will be generated to reflect the acceptance of the assistance request and the comment included 

after completing the assistance.  

 

The provider profile will now return to the previous status, and the provider will again be able to edit the profile.  

However, if changes were made by the coalition, the provider profile will become Incomplete.  The provider user 

may review the changes, sign and certify, and submit to the coalition. 
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 Assist Provider 
In addition to the Request Assistance feature available to providers, coalition users can also help providers through 
the Assist Provider feature. This feature allows coalition users to put a provider profile in Assistance Accepted 
status and make edits to the profile without the provider having to submit a request for assistance. The initial 
profile status has a role in the steps required for editing and the resulting status. For example, if the initial provider 
profile status is Active*, when the assistance is completed, the profile status becomes Incomplete in order for the 
provider to review and approve the changes. Other initial statuses are maintained when the assistance is 
completed (i.e. Incomplete stays Incomplete after assistance is completed). Editing is not available for Imported or 
Inactive profile statuses. Additionally, if the initial provider profile status is Submitted**, the status must first be 
changed to Coalition Reviewing in order for editing to occur. See the chart below: 

Initial Profile Status Editing Available Coalition Reviewing 
Necessary 

Resulting Status 

Incomplete Yes No Incomplete 

Submitted** No Yes Submitted 

Coalition Reviewing Yes No Coalition Reviewing 

Request Assistance Yes No Varies 

Active* Yes No Incomplete 

Rejected No No Rejected 

Inactive, Imported No N/A N/A 

 

Go to Provider > Search. 
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Enter the provider ID, Click Search. 

 

Identify the Program Year / Profile Status that needs assistance. The click the Profile ID. 

 

Click the Assist Provider button 
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The current status on the provider profile changes to Assistance Accepted. The provider’s Business tab is not 

accessible. Access to this information will be available for editing with a future release. All other tabs on the 

provider profile are accessible and the fields are editable with the exception of some fields on the Facility tab. 

 

A provider note is added: “Coalition initiated Request Assistance to assist provider” 

 

Make any necessary edits to the profile. 
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Save all changes and return to the Review screen. 

 

 

 



 160 

Click the Assistance Complete button. 

 

 

 

A pop-up displays. Write a comment in the comment box and click Submit.  

NOTE: Send message is checked by default. When Send message is checked, a message is sent to the provider and 

a provider note is written; when it is un-selected, only a provider note is written. 
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The current status changes back to Incomplete. 

 

A provider note is added: “Provider assistance completed. Message sent to provider.” The provider note will also 

include any comments entered. 
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Coalition Reviewing Status 
To process a provider profile, the coalition user will select the Submitted work queue.  

 

Then, the coalition user will click the Provider ID link of the record assigned to review.  

 

The Administrative Review page will display. Click the Change Profile Status button to change the profile status to 

Coalition Reviewing.   
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Then, click the Save button to continue.  

 

Once the status is changed to Coalition Reviewing, the following page will display:  

 

To begin the review process, the coalition user will go back to the Provider Profiles Quick Access Dropdown Queue, 

select Coalition Reviewing, and find the profile that was set to Coalition Reviewing.    

After coalition review, the profile can be changed to Rejected, Inactive, or Active status. If the profile does not 

have the information needed to determine if the provider is eligible for funding, the profile should be Rejected. If 

the provider is no longer providing School Readiness or Voluntary Prekindergarten services, the profile should be 

set to Inactive. If the coalition determines the provider is eligible to receive funding, the profile should be set to 

Active.  
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Rejected Status 
To reject a profile, the coalition user must click the Change Profile Status button. 

Once on the Change Profile Status page, select Rejected in the Profile Status dropdown menu. 

Enter the reason for the rejection in the comments section; the comment will be included in the automated email 

sent to the Provider Portal user from DONOTREPLY@oel.myflorida.com. After entering all required fields, click 

Save to proceed. 

 

 

 

The status has been updated at the top of the review page. 

 

Once in Rejected status, the coalition user or coalition admin will not be able to edit the profile until the profile is 

resubmitted by the Provider Portal user. 
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Active Status 
To activate a profile, the coalition user must click the Change Profile Status button. 

Once on the Change Profile Status page, select Active in the Profile Status dropdown menu. 

An automated email will be sent to the Provider Portal user from DONOTREPLY@oel.myflorida.com. After 

entering all required fields, click Save to proceed. 

 

 

The status has been updated at the top of the review page. 

 

  



 166 

Changing Profile Status 
Once the coalition user is ready to update the status of a profile, click the Change Profile Status button.  

 

Once the new status is selected, the coalition user has the ability to add a comment and click the Save button.  
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Provider Profile Edits 
After a provider profile has been set to Active status, if the provider makes a change and re-submits the profile, a 

notification will appear on the Administrative Review page to notify the coalition user that a change has been 

made to a profile section.  

 

To see what specific answer has changed, expand the section that has the red flag and another red flag will show 

what answer has changed.  

 

To see what the previous answer was, hover over the red flag.  

 

Verifying Documents 
Provider documents can be verified and have a begin date and expiration date added by clicking the Documents 

tab from the Administrative Review page.  
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A coalition user will then view the document by clicking the View button, complete the Begin date and Expiration 

date for the document, and verify the document by clicking the check box. A coalition user can re-verify a 

document for a subsequent contract year even if the document was verified in the previous contract year.  

 

 

Document Library Management 
The Document Library Management function allows a coalition user to review documents uploaded to the Provider 

Profile.  

To access the Document Library Management function, coalition users will click the Provider button and then 

Document Library Management.   
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The folder list is standard for all providers, but a coalition-specific folder can be added. To add a new folder, 

coalition users will click the Add New Folder button.  

 

The coalition user will then create the new folder name and click the Save Changes button.  
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To rename a folder that is not predefined, coalition users will click the Rename Folder button.  

 

The coalition user will then select the folder, rename the folder and click the Save Changes button.  
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The folder list is standard for all coalitions.  

 

Coalition users can view a provider’s documents by selecting a provider and folder, then clicking the View Files 

button.  
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Coalition users can upload a new file to a provider’s folder by clicking the Upload New File button, browsing for 

the file and clicking the Attach Selected Document button to complete the upload.  
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Coalition users can rename a file in a provider’s folder by clicking the Rename File button, selecting the file, 

inserting a new file name and clicking the Save Changes button.   
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Coalition users can download or archive a document in a provider’s folder by clicking the Download or Archive 

button, respectively. If the provider has reached the maximum number of documents allowed on the Profile 

Documents tab, archiving documents will free up room to allow additional documents to be uploaded for coalition 

verification. The Archive function will save the document to the OEL database and will not be accessible again to 

the coalition user.  
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Provider Contracting for Coalitions 
Prior to initiating SR contracts for a program year, the coalition must establish the SR Plan Rates (under Admin 
Functions> Rates Management> SR Plan Rates) and the SR Holiday Schedule (under Admin Functions> Calendar 
Management> SR Plan Rates).   
 

Initiating a Contract 
Only providers with an Active profile are eligible to have an electronic contract initiated, and only coalition admins 

have the ability to initiate a contract. The Coalition Admin must click the Contracts button first, then, click the 

+Initiate Contract button.   

 

 

Select a contract type from the Type dropdown menu. 
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SR Contract 
SR contracts will default to an electronic process, although a paper process can still be used. Select the responsible 

parties for development screenings and subsequent development screenings, notice recipient(s) from the Email 

Notification To: dropdown menu, select multiple sites (if needed), and click the Save button.  
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The contract defaults to end at the end of the fiscal year.   

 

The coalition can elect to have DCF notified of a contract initiation process. DCF will also then receive notifications 

of a certified and terminated contract.  
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After the Save button is clicked, the following will display. Fill out the dropdowns and click Next Step. 
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After clicking Next Step, the following will display. Fill out the dropdowns and click Save & Initiate.  

NOTE: The same Quality Improvement Plan Strategies cannot be selected.  

 

After clicking the Save & Initiate button, the following will display. Click Yes to continue.  

 

 
After clicking Yes, the following will display. Select an email address in the Email Notification To: field and click 
Send & Initiate.  
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The SR contract has a status of Initiated.  

 
 

Edit a Drafted Contract 
If the coalition user clicks the Save button, instead of the Save & Initiate button, the VPK or SR contract is given a 
Drafted status.  
 

 
 

To edit a Drafted contract, click the Edit Contract button.  
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VPK Contract 
VPK contracts will default to an electronic process, although a paper process can still be used. Select notice 

recipient(s) from the Email Notification To: dropdown menu, select multiple sites (if applicable), and click the Save 

button.  
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After the Save button is clicked, the following will display. Click Save & Initiate.  

 
 

After clicking the Save & Initiate button, the following will display. Click Yes to continue.  

 
 

After clicking Yes, the following will display. Select an email address in the Email Notification To: field and click 
Send & Initiate.  
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The VPK contract has a status of Initiated.  

 

 

VPK-APP 
VPK-APPs (VPK Applications) – the OEL-VPK 10, OEL-VPK 11A, and OEL-VPK 11B – will default to an electronic 

process, although a paper process can still be used. Select notice recipient(s) from the Email Notification To: 

dropdown menu and click the Save button.  
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School Board/District Contracts 
For SR and VPK contracts with a school board/district, the board/district may require provider contracts be signed 

manually, not electronically. In this situation, the coalition can initiate a contract electronically, which will populate 

the contract with the profile data, then the provider will fill out the contract and print it for manual signature by 

the school board/district. The coalition cannot electronically sign a contract without a provider’s electronic 

signature, so after the manually signed contract is received by the coalition and manually signed by the coalition, 

the coalition will cancel the electronic contract, initiate a paper contract with the provider, upload the signed 

contract, and certify the contract.  

To initiate a paper contract, click the Initiate Contract button. 

 

Then, click the Paper Process? checkbox. Click Browse…, upload the signed contract, and click Save.  

NOTE: Once the Save button is clicked, the paper contract status is Certified.  
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  Cancelling a Contract 
A VPK Provider Application, VPK Contract or SR Contract can be cancelled if the contract status is Initiated, 

Incomplete, Submitted, Coalition Reviewing or Reviewed. The only statuses when a contract cannot be cancelled 

is Rejected or Certified. To cancel a contract, click the Cancel button. The below example is for cancelling a VPK 

Provider Application, so the button reads Cancel Application. If a VPK Contract or SR Contract is cancelled, the 

button will read Cancel Contract.  

 

 
 
 
After clicking the Cancel Application button, the following message will display. Click the No or Continue button.  
 

  
After clicking the Continue button, the following message will display. Enter a reason, and click the Submit button. 
Click the Dismiss button to not cancel the application/contract.  
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Processing a Contract 
Select any of the contract options from the Provider dropdown menu to see a list of contracts with the selected 

status.  

  

SR, VPK and VPK Application contracts share the same contract statuses, while Local and VPK SIS contracts have a 

limited number of statuses.  
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Contract Status Definitions 

Initiated 
The coalition has started the provider contract process for a provider with an Active profile.  

Incomplete  
The provider has started, but not submitted, a contract.  

Submitted 
The authorized provider representative has electronically signed the contract and has submitted it to the coalition 

to be certified.   

Coalition Reviewing  
The coalition is actively reviewing the contract.  

Request Assistance (not yet available) 
The provider has requested assistance to complete the contract.  

Reviewed 
The coalition has reviewed, but not certified, the contract.  

Rejected 
The contract has missing or incorrect information that is necessary to approve the contract. Rejecting a contract 

will allow the provider to correct contract inputs that occurred during the contract edit process (such as 

signatures). Data that are populated in the contract from the provider profile cannot be changed by rejecting the 

contract. This information has to be corrected in the provider profile. Then, a new contract will need to be initiated 

to gather the new profile information.  

Certified 
The authorized coalition representative has signed and certified the contract, and the provider is ready to provide 

early learning services. 

Terminated 
The coalition or provider, for one of several reasons, has revoked a provider contract: inactive provider, 

termination for cause, termination for fraud, emergency circumstances or provider decision.  

Not Eligible 
The coalition has determined that the provider is not eligible for a contract.  
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Reviewing a Contract 
To review a contract, the coalition user will click the Provider dropdown menu, select a contract type (e.g. SR, VPK, 

VPK Application, etc.) and click Submitted to see all submitted contracts for that contract type.  

 

Click the Contract ID of the desired contract.  

 

Then, the following will display. Click the Change Contract Status button.  
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The following will display. Select Coalition Reviewing from the Select New Status dropdown menu and click the 

Save button.  
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Signing a Contract 
The coalition admin can view the contract by clicking the Preview Contract. To electronically sign the contract, 

click the By Electronic Signature checkbox.  
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After clicking the checkbox, the following message will display. Enter the Title of Signator and click Yes.  

 

 

After clicking the Yes button, the electronic signature of the signatory and the date/time will populate in yellow. 

NOTE: The Provider and Coalition representatives will not be the same, as in the below example.  
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Certifying a Contract 
Once the contract has been electronically signed, the coalition admin can certify the contract by clicking Change 

Contract Status. 

 

After the Change Contract Status button is clicked, the following will display. The coalition admin will change the 

Contract Status to Certified and click Save.  
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After the Save button is clicked, the following will display.  

 

If the contract was not electronically signed, the following error message will display. Click Cancel and return to the 

electronic signature page.  
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Rejecting a Contract 
To reject a contract, the coalition admin will select a Contract Status of Rejected, select a Rejection Reason and 

click Save. 

 

 

Terminating a Contract 
To terminate an SR or VPK contract, the coalition admin will select a Contract Status of Terminated, and the 

following message will display. Click the Ok button to continue.  
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Then, select a Termination Type and corresponding Termination Reason, then click Save. 
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Processing a VPK-APP 

Reviewing a VPK-APP 
To review a VPK-APP, the coalition user will click the Provider dropdown menu, select VPK Applications and click 

Submitted to see all submitted VPK-APPs.  

  

Click the Contract ID of the desired VPK-APP.  
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Then, the following will display. 

 

The coalition user can click on each tab to review the information.  

To verify a document, the coalition user can click the Verify button on the VPK Director, VPK Instructor, VPK 

Calendars and VPK Class(es) tabs.  
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After clicking the Verify button, the coalition user’s email address and verification date will populate in each tab.  
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Editing a VPK-APP 
Coalition users can click the Edit button on the VPK Director and VPK Instructors tabs to edit information. 

Documents may be uploaded by users, and un-verified documents may be deleted.  

 

If edits are made to a tab, the coalition user must click the Update button to save the changes. 

 

Changing VPK-APP Status 
A coalition user can change a VPK-APP’s status by clicking the Change Status button on any tab of the VPK-APP. 
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Then, select a new status.  

 

VPK-APP Status Definitions  

Coalition Reviewing  

The coalition is actively reviewing the VPK-APP.  

Reviewed 

The coalition has reviewed, but not certified, the VPK-APP.  

Rejected 

The VPK-APP has missing or incorrect information that is necessary for approval. 

Certified 

The VPK-APP is approved.  

Not Eligible 

The coalition has determined that the provider is not eligible for a VPK-APP.  

 

NOTE: The provider can edit the VPK-APP on any status, but must certify and submit the VPK-APP to notify the 

coalition that edits have been made.   
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Refreshing a VPK-APP 
If a Provider Portal user has changed a profile field that affects the VPK-APP, the following will display on review.  

 

After the coalition user clicks the Change Profile Status button…  

 

…the following will display.  

 

When the Save button is clicked, the provider’s VPK-APP status will be changed to Incomplete. The Provider Portal 

user will then review the VPK-APP and re-submit the edited VPK-APP. If the coalition user un-checks the Update 

existing VPK App and notify provider checkbox, but decides to update and notify, the VPK-APP can be re-initiated 

again and the checkbox left checked.  
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The provider owner and VPK director will receive the following email from DONOTREPLY@OEL.myflorida.com. 

 

After the Provider Portal user submits the edited VPK-APP, the coalition user will click the Change Status button… 
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…and change the VPK-APP status to Certified.  

 
 

The coalition user can also refresh the VPK-APP by clicking the Initiate Contract button.  

 

This will change the status of an existing VPK-APP to Incomplete from any status.  

 

A Provider Portal user can also trigger a refresh of a Certified VPK-APP by editing the VPK-APP. This will change the 

status to Incomplete from Certified and then the user can submit the edited VPK-APP for coalition review.  
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Vendor Number Entry 
A vendor number is required for contracted providers.  Coalitions may review a Tableau report to identify 

providers with or without vendor numbers, as well as create and manage vendor numbers.   

Accessing the Vendor Number Report in Tableau 
Coalition users with a Tableau account may access the Vendor Number Report by going to https://oel-

reports.floridaearlylearning.com.  From Projects, select the ~Mod 3.0~ folder.  Select the Vendor Number Report 

workbook.  Select the Provider Vendor Dashboard view (to search specific providers) or the Vendor Number 

Report view (to see all providers).   

Adding/Viewing Vendor Numbers 
To begin, go to the Reimbursement menu item and select Vendor Number Entry. 

 

A provider search page displays.  Enter search criteria for a provider and click Search. 

 

Results display.  Click the View Vendor Number button. 

https://oel-reports.floridaearlylearning.com/
https://oel-reports.floridaearlylearning.com/
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The Vendor Number List for the provider displays with several sections: provider information, coalition drop down, 

saved vendor number list, and add a vendor number.  The coalition drop down is restricted to the user's coalition. 

 

In the Add a Vendor Number section, enter the required fields. 
a. Vendor Number – alphanumeric field that holds the local accounting system’s vendor number as input by 

the coalition 
b. Description – optional field (useful for labeling when this vendor number should be used) 
c. EFS Legacy Provider/Extension – optional field (useful for including EFS Legacy values) 
d. Funder Type – drop down; select a funding type (SR, Local, or VPK) or select All to apply the same number 

to all funding types for the provider. 
a. The vendor numbers created may be assigned to attendance rosters for reimbursement.   
b. It is possible to create multiple vendor numbers for the VPK program that can later be assigned to 

specific classes (if needed). 
 
When complete, click the Add Vendor Number button.  The saved vendor number list updates with the new 
information. 
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Removing Vendor Numbers 
To remove a vendor number, follow the steps above to locate the provider through the Vendor Number Entry 

provider search and click the View Vendor Number button.  In the saved vendor number list, click the Remove (X) 

button.  A confirmation window displays.  Click Yes to remove the vendor number or click Cancel to abandon the 

action. 

Assigning Vendor Numbers to a VPK Class 
Assigning a vendor number to a VPK class is an optional feature and may not be used by all coalitions.  During 

reimbursement, the system will first look to see if a VPK class has a specific vendor number assigned, if not, the 

system will use the top VPK vendor number created (if more than one VPK vendor number exists). 

To assign a vendor number to specific VPK class, follow the steps above to locate the provider through the Vendor 

Number Entry provider search, click the View Vendor Number button, and create the vendor numbers to be used 

by each class at the provider.  

 
 
With the VPK vendor numbers created, go to the Provider menu item and select Search.  Enter criteria to locate 
the VPK provider and click the Search button.  Results display.  Click the Profile ID link to open the provider's 
profile. 
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On the provider's Administrative Review task bar, click the Contracts button. 

 
 
Then, click the View button for the VPK Provider Application (VPK-APP) for the applicable program year. 

 
 
The VPK Provider Application displays.  Click the VPK Class(es) tab.  For each class that needs a specific vendor 
number assigned, click the Update button. 

 
 
A window displays with the available VPK vendor numbers.  Choose the vendor number can click the Select button. 

 
 
Now, the vendor number is assigned to the specific VPK class.  Repeat as needed. 
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Provider Messaging 

Broadcast Message Management 
The Broadcast message management function allows coalitions to send messages to all providers in the coalition 

service area. This function is only available to coalition admins and OEL admins. Currently, coalitions cannot send 

to SR, VPK, or CCR&R providers each, but must send a message to all providers, regardless of services provided.  

To access the Broadcast message management function, coalition admins will click the Admin Functions button, 

select Messaging Management and then Broadcast messages.  

 

 

Then, click the Create New button.  

 

The coalition admin will then select the audience for the message, decide which county(ies) (if a multi-county 

coalition) for the message, complete the Message field and select the Begin Date and End Date for the message. 

Unclicking the Show check box will hide the message from providers. Click the Save button to send the message.  
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Provider Message Management 
The Provider message management function allows coalitions to send messages to a specific provider in the 

coalition service area. This function is only available to coalition admins and OEL admins.  

To access the Provider message management function, coalition admins will click the Admin Functions button, 

select Messaging Management and then Provider messages. 
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Then, click the Create New button.  

 

 

The coalition admin will then complete the Provider Message and Provider Site fields. When the provider reads the 

message, the Read By and Read Date fields will be completed. Click the Save button to send the message.  
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VPK Enrollment for Coalition Users 
Coalitions may create new enrollments through the system or upload a bulk enrollment file in lieu of a provider 

submission.  Additionally, coalition users manage enrollments by reviewing provider requests or saving changes 

directly.  

Creating New Enrollments  
Coalition users will navigate to the VPK Application menu item and select the Search option to locate the approved 

VPK child.   

 

Clicking on the child's COE number opens their application record.  
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Within the application record, click the Enroll button. 

 

Now, the enrollment record opens for the child.  

 

First, enter the provider name.  As text is entered, matching providers are identified and display in a drop down.  

Select the provider and press the Enter key.  Then, the provider information appears.  

 

Use the Class ID drop down to select the appropriate class for enrollment.  Then, the class information appears.  

Next, enter the anticipated start date for the child.   

NOTE: The anticpated start date cannot be before the class start date or before the COE issue date (or before a 

termination date) - see highlighted dates.   
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The page refreshes and the application records appears.  Now, the button says View Enrollment.  When clicked, 

the Enrolled record displays. 

Creating New Enrollments through a Bulk File Upload  
In addition to the enrollment method described in “Creating New Enrollments through the Coalition Services 

Portal” coalition users may submit enrollment requests on behalf of providers via a file process.  To begin, click the 

VPK Enrollment menu item, then Bulk File Upload.  The bulk file processing page displays. 
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Next, click on the link to download the CSV file template.  The file may appear at the bottom of the computer 

screen depending on the user’s browser.  

 

Open the file and expand the columns.  Each column is explained below. 

 

A. Provider ID = this is the provider ID for the site. 
 

B. Certification Number = this is the child’s certificate number listed on their COE.  The field is not case 
sensitive, however, the certificate number must be entered exactly as it appears on the COE (i.e. 
VPK####-YYYY). 

 
C. Child First Name = this is the child’s first name listed on their COE.  The field is not case sensitive. 

 

D. Child Last Name = this is the child’s last name listed on their COE.  Do not include a suffix (if any). The field 

is not case sensitive. 
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E. Child DOB (MM/DD/YYYY) = this is the child’s date of birth listed on their COE.  The field will accept 

M/D/YYYY as well. 

 

F. VPK Program Year = this is the child’s approved VPK program year listed on their COE.  The field is looking 

for the first 4-digit year only.  For example, if the VPK program year is 2017-2018, the entry would be 

2017.  Generally, the 4-digit VPK program year matches the year included at the end of the child’s COE 

number.   

 

G. Class ID = this is the desired class’s 4-digit ID.  The class ID must be entered as the 4-digit assigned ID.  Do 

not include the class name (if any).  Looking at the example below, the entry would be “AS17” not 

“Songbirds” or “AS17-Songbirds.” 

 
 

H. Anticipated Start Date (MM/DD/YYYY) = this is the date the child will begin attending class.  Typically, 

this is the class start date unless the child is starting after the class begins.  NOTE: An anticipated start 

date cannot be before the class start date or after the class end date.  And, an anticipated start date 

cannot be before the child's COE issue date. The field will accept M/D/YYYY as well. 

 

I. MSID (XX-XXXX) = this field is for public schools only.  Public schools may enter their Master School 

Identification (MSID) number in a 6-digit format, where the first 2 digits are the district number followed 

by a hyphen and 4-digit school number.  The MSID number can be used in lieu of the Provider ID in 

column A.  Both IDs are accepted. 

When the file is complete, name it and save it as a CSV file type.   

NOTE: It may be helpful to include your provider name and class in the file name if troubleshooting is ever 

necessary. 
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When changing the file format to CSV, Excel often displays a message to ask if you want to keep using that format.  

If this message appears, click Yes. 

 

Click the Upload button.  A window displays.  Select your file and click Open.  

 

The file upload will begin.  The file details will populate on a row and turn green.  Click the Refresh button to 

populate the results. 

 

The file details will be updated.  The file size, total records count, committed records count, failed records count, 

processed time, status, and final results are updated.  The file results are also returned and can be downloaded by 

clicking on the Download button.   
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In this example, there is one failed record and three committed records.  The file download will include the error 

message and status for each record submitted.  The three committed records are now “Enrollment Submitted” and 

the failed record was not included because of an invalid date of birth.  The same validations that occur with a 

manual child enrollment occur with the bulk enrollment file process.  

 

The three committed records are displayed on the class’s enrollment roster as “Enrollment Submitted" and appear 

in the VPK Enrollment> Enrollment Action Requested work queue for review/approval/rejection.  In addition, the 

family receives a notification that their child’s enrollment is in progress.  The same processes that occur with a 

manual child enrollment occur with the bulk enrollment file process.  

NOTE: When correcting records and re-uploading the file, be sure to remove the “Error or Status” column as it is 

not accepted for the upload.  Also, it is best to NOT include records that have already been submitted successfully 

as they will now error as having been processed.  When removing successful records and the Error or Status 

column, it is best to highlight the row/column and use the cut/delete option instead of just deleting the 

information.  Excel often retains formats even if the cells are now empty. 
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Reviewing VPK Enrollment Requests 
Coalition users will navigate to the VPK Enrollment menu item and select the Enrollment Action Requested work 

queue to review/approve/reject enrollment requests made by the provider.  Requests include new enrollments, 

class transfers, and child terminations. 

 

The Enrollment Action Requested work queue displays the certificate of eligibility (COE) number, child name, 

parent name, provider name, provider phone number, provider county, program year, and enrollment status.  The 

columns may be sorted by clicking on the column header.  Each column may be filtered by typing criteria in the 

column's filter field.  Additionally, there is a program year filter and search feature that can filter results. 

 

Clicking on the child's COE number opens the enrollment record.  Clicking on the parent's name opens the 

household view. 
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The child’s enrollment record contains Provider Information (on the left) and the Current Enrollment Information 

(on the right).  The Enrollment Actions To-Date area displays the current request that was made by the provider 

with action buttons to Approve, Reject, or Set Coalition Reviewing. 

 

Below, there are two more sections: Other Enrollments for Child and Case Notes.  The Other Enrollments for Child 

area displays the enrollment history attached to this COE (i.e. cancellations, class transfers, rejections, etc.).  The 

Case Notes area allows coalition users to create and view case notes related to the enrollment.   

To create a case note, type in the text box area and click Add Case Note.   

NOTE: When assigning a custom code to a case note, select the Custom Code Type and Custom Code prior to 

clicking Add Case Note. 

To view case notes, click Status Records.   
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In this example, the child had a VPK County of Service Change during the enrollment process.  The COE listed Clay 

as the county of service and it was automatically updated to the provider’s county (Leon) during the enrollment 

process.  This enables the coalition of the provider to process the enrollment request without having the original 

coalition manually update the child’s application record. 

Case notes have a search feature that can filter results.  Click Close to close the window. 

New Enrollments 
New enrollment requests appear in the Enrollment Action Requested work queue as Enrollment Submitted.  Click 

on the COE number to continue.  The child’s enrollment record opens.  The Enrollment Actions To-Date area 

displays the current request that was made by the provider with action buttons to Approve, Reject, or Set to 

Coalition Reviewing. 

Set Coalition Reviewing  

Coalition users may place an enrollment request in the Coalition Reviewing status by clicking the Set Coalition 

Reviewing action button.  This action changes the record’s status from Enrollment Submitted to Coalition 

Reviewing and moves the record to the Coalition Reviewing work queue.  The family, provider, and coalition will 

see the status update within the respective portals.  The family and provider will not receive an email notification 

for this action.   

Reject  

Coalition users may reject an enrollment request by clicking the Reject action button.  A window will appear to 

enter comments for the enrollment case note.  The user must click Save to complete this action; otherwise click 

Cancel to abandon the rejection.  Rejecting an enrollment request changes the record’s status from Enrollment 

Submitted to Enrollment Rejected.  In this status, the enrollment request is cancelled and the enrollment process 

starts over.  The provider’s VPK Director receives an email notification to inform them the enrollment process 

could not be completed for the child and the child’s record is no longer listed on the class roster in the Provider 

Portal.  The family also receives an email notification to inform them the enrollment process could not be 

completed for their child; instructions are provided to log into the Family Portal to download the child’s COE and 

select another VPK provider.      

Approve  

Coalition users may approve an enrollment request by clicking the Approve action button.  Approving an 

enrollment request changes the record’s status from Enrollment Submitted to Enrolled.  The family, provider, and 
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coalition will see the status update within the respective portals.  The family receives an email notification to 

inform them the enrollment process is complete for their child.  The provider will not receive an email notification 

for this action.     

Class Transfers 
Class transfer requests appear in the Enrollment Action Requested work queue as Enrolled-Change Requested.  

Click on the COE number to continue.  The child’s enrollment record opens.  The Enrollment Actions To-Date area 

displays the current request that was made by the provider with action buttons to Approve, Reject, or Set 

Coalition Reviewing.   

NOTE: During a class transfer, a child has two enrollment records; one for their current class (Enrolled) and one for 

the pending class transfer (Enrolled-Change Requested). 

 

Set Coalition Reviewing  

Coalition users may place a class transfer request in the Coalition Reviewing status by clicking the Set Coalition 

Reviewing action button.  This action changes the pending class transfer record’s status from Enrolled-Change 

Requested to Coalition Reviewing and moves the record to the Coalition Reviewing work queue.  The family will 

not see the status change on their dashboard in the Family Portal.  However, the provider and coalition will see the 

status update within the respective portals.  The family and provider will not receive an email notification for this 

action.   

Reject  

Coalition users may reject a class transfer request by clicking the Reject action button.  A window will appear to 

enter comments for the enrollment case note.  The user must click Save to complete this action; otherwise click 

Cancel to abandon the rejection.  Rejecting the pending class transfer record cancels the class transfer.  The 

rejected class transfer request is no longer active or visible to the provider in the second class; only the enrolled 

record remains active in the first class.  The provider’s VPK Director receives an email notification to inform them 

the change request was not approved for the child.  The family will not receive an email notification for this action.      

Approve  

Coalition users may approve a class transfer request by clicking the Approve action button.  Approving a class 

transfer request will change the pending class transfer record’s status from Enrolled-Change Requested to Enrolled.  

The enrolled record in the first class is terminated with the class transfer effective date.  The family, provider, and 

coalition will see the status update within the respective portals.  The family and provider will not receive an email 

notification for this action.      
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Terminations 
Termination requests appear in the Enrollment Action Requested work queue as Enrolled-Change Requested.  

Click on the COE number to continue.  The child’s enrollment record opens.  The Enrollment Actions To-Date area 

displays the current request that was made by the provider with action buttons to Approve, Reject, or Set 

Coalition Reviewing.   

 

Set Coalition Reviewing  

Coalition users may place a termination request in the Coalition Reviewing status by clicking the Set Coalition 

Reviewing action button.  This action changes the pending termination record’s status from Enrolled-Change 

Requested to Coalition Reviewing and moves the record to the Coalition Reviewing work queue.  The family will 

not see the status change on their dashboard in the Family Portal.  However, the provider and coalition will see the 

status update within the respective portals.  The family and provider will not receive an email notification for this 

action.   

Reject  

Coalition users may reject a termination request by clicking the Reject action button.  A window will appear to 

enter comments for the enrollment case note.  The user must click Save to complete this action; otherwise click 

Cancel to abandon the rejection.  Rejecting the request cancels the termination and changes the record's status 

from Enrolled-Change Requested to Enrolled.  The provider’s VPK Director receives an email notification to inform 

them the change request was not approved for the child.  The family will not receive an email notification for this 

action.      

Approve  

Coalition users may approve a termination request by clicking the Approve action button.  Approving a 

termination request will change the record’s status from Enrolled-Change Requested to Enrollment Ended (once 

the termination effective date is reached).  The family, provider, and coalition will see the status update within the 

respective portals.  The provider’s VPK Director receives an email notification to inform them the enrollment has 

ended and the child’s record is no longer listed on the class roster in the Provider Portal (once the termination 

effective date is reached).  The family also receives an email notification to inform them the enrollment has ended; 

instructions are provided to log into the Family Portal to request reenrollment if hours remain unused.  
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         Edit Termination Information 

If the VPK enrollment status is Enrollment Ended (Terminated), a coalition admin can change the termination date 

or termination reason if the date and/or reason was incorrectly entered by the provider. 

From the enrollment screen, click the Edit Termination Info link.  

 

Fill out the required fields and click Save.  
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Saving Enrollment Changes Directly 
Coalition users may also open an enrollment record and make changes directly, such as changing a class, 

terminating the enrollment or cancelling the enrollment. 

Class Transfers 

To save a class transfer change, open the enrollment record.  Use the Class ID drop down to select the class to 

transfer to. 

 

When the class changes, a "Class Change Effective Date" appears.  Enter the first day the child will begin in the new 

class and click Save. 

 

The page refreshes and the enrollment record is updated.   
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Terminations 

To save a termination change, open the enrollment record and click Terminate.  A pop-up message displays to 

collect termination information.  Enter the last day that services will be/were rendered and select the reason for 

termination.  The Termination Effective Date is displayed below the Last Day of Services as one day after the last 

day of services.  Therefore, the Termination Effective Date is the first day the child is NOT attending class.  Click 

Save to complete the task or click Close to abandon the termination and close the window.   

 

The page refreshes and the enrollment record is updated.   

Update Anticipated Start Date 

To save an updated anticipated start date, open the enrollment record.  Enter a new Anticipated Start Date and 

click Save.  NOTE: An anticipated start date cannot be changed if an Actual Start Date is recorded.  Also, the 

validations must still be met (i.e. the anticipated start date cannot be before the class start date or after the class 

end date; and, it cannot be before the child's COE issue date).   
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Remove Enrollment from Provider - Child Never Attended 

Coalition users may remove an enrollment from a provider, in effect canceling the enrollment.  This feature may be 

used if the child never attended and no reimbursement will be sought for the enrollment.  To use this feature, 

open the enrollment record and click the Remove Enrollment from Provider - Child Never Attended button.  A 

window displays to confirm the action.  Click Remove to continue or click Cancel to abandon the action and close 

the window.  

 

Removing an enrollment changes the record’s status to Enrollment Cancelled and the enrollment process starts 

over for the family.  The provider’s VPK Director will receive an email notification to inform them the enrollment is 

removed; no attendance or reimbursement may be sought.  The child’s record is no longer listed on the class 

enrollment roster or attendance roster in the Provider Portal.  The family will receive an email notification to 

inform them the enrollment for their child was cancelled; instructions are provided to log into the Family Portal to 

download the child’s COE and select another VPK provider. 

This feature is available until the actual start date is recorded through the attendance process.  When the actual 

start date is populated in the column, the Never Attended button is no longer available.   
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Review Class Rosters 
Coalition users can navigate to the VPK Enrollment menu item and select the Class Rosters link to view provider 

rosters by class.   

 

The View Class Rosters page displays. 

 

Enter the provider name or provider ID and click the Search for Provider button.  Next, the provider information 

and class selections appear. 
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Select the VPK program year, session, and class to view the roster.  When selected, class information displays.  

 

Columns may be sorted, filtered, and searched as needed.  Clicking the View Enrollment button opens the child's 

enrollment record.  The class rosters duplicate the provider roster view (without provider action buttons). 
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Attendance and Reimbursement Processing 
The EFS Mod financial system operates on a 12-month payment year (July 1 to June 30).  Each payment period or 

month, providers submit attendance rosters for childcare services rendered during a service period.  As these child 

records move through the payment cycle, different statuses are assigned.   

 

 

 

 

1. Need Attendance – Outstanding attendance for a service period not yet submitted. 

2. Have Attendance – Submitted attendance.  

3. Closed Attendance – Approved attendance. 

4. Payment Verified – Verified reimbursement detail. 

5. Have Adjustment - Approved attendance in need of reimbursement detail correction. 

6. Updated – Locked reimbursement detail. 

7. Paid – Transmitted reimbursement detail. 

At any given time, coalitions are see how many individual records are in each status for the current payment 

period by viewing the Review & Close Payment Period page (under the Reimbursement> Reimbursement Closeout 

menu).   

 

Payment Periods 
Attendance records for service periods move through different statuses within a payment period.  The payment 

period automatically opens on the first of each month and automatically closes on the last day of the month.  

However, coalitions may choose to manually end a payment period early, such as on the 20th of each month, by 

using the Review & Close Payment Period feature.  Closing a payment period, whether automatically or manually, 

opens the next payment period.  Only one payment period is open at a time.  Any records that are not in the Paid 

status when the payment period closes, carryover into the next payment period in the same status so they may 

continue to be worked until the Paid status is reached.   

Need 
Attendance

Have 
Attendance

Closed 
Attendance

Payment 
Verified

Updated Paid

Have  

Adjustment 



 232 

Service Periods 
Service periods are one month.  Service periods begin on the first day of the month and end on the last day of the 

month.  When a child is enrolled with a provider, an attendance record is created.  Providers are able to mark 

attendance during service periods in which the child is enrolled, beginning on the child’s anticipated start date 

until the child’s enrollment has ended.  Each service period has a defined due date established by the statewide 

provider contract process.  Providers that submit attendance before the end of the service period or after the 

service period due date are messaged accordingly.  For example, attendance cannot be recorded for a day that has 

not occurred yet, therefore providers are alerted that future days are not reimbursable upon early submission.  

When submitting after the service period due date, providers are alerted that reimbursement may be delayed. 

Attendance Process - VPK 
The provider attendance process is based on reporting exceptions.  VPK providers must report absences for 

enrolled children during each service period for each approved class.  Information about the class, such as the 

start/end date and non-instructional days, are from the provider’s VPK Provider Application.  Information about 

the child, such as the child’s anticipated start date and termination effective date, are from the child’s enrollment 

record.  Corrections to the class information or child information must be made in their source areas, not the 

attendance feature.  Class and child information are refreshed each time an un-submitted attendance roster is 

opened by the provider.   

Providers record attendance for each day the class is scheduled to be in session during the child's enrollment.  As 

days occur in the month, they default to present (X).  Providers click on a child’s name and day to change the 

present (X) indicator to absent (A).  No absent reasons or other information is collected on the provider's screen 

during the VPK attendance process.  Features include a Search button (to search for any criteria included in the 

roster list, such as a name, age, billing group) and a Summary button (to display the entire class roster in a single 

month view and print). 
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As absences are recorded, they are saved automatically.  However, providers may choose to use the Save button 

to save their work periodically or when moving from child to child.  When all child absences are recorded for the 

service period, the provider will click the Submit to Coalition button.  This brings the provider to a Sign and Certify 

page where the page displays the summary view and collects the user’s submission information.   

Once submitted, providers see a submitted message in the class summary box and the "SUB" status in the Status 

column for each child record on the attendance roster.  As the individual child records move through the payment 

period, their status is reflected in the provider’s attendance roster Status column.  On the Provider Portal, the child 

record statuses may be "SUB" (Submitted), "REJ" (Rejected), or "APP" (Approved).  It is possible that a provider has 

some children listed as Approved and some children listed as Rejected after their submission.  Providers are 

notified when rejections occur so they may re-visit the attendance roster to edit and re-submit.  Only records that 

do not have a status or are rejected may be edited. 

 

Child record statuses also change on the Coalition Services Portal.  Prior to the attendance roster being submitted 

by the provider, the child records were in the "Need Attendance" status.  Once submitted, the child records are 

moved to the "Have Attendance" status.  Approved records move forward to the "Closed Attendance" status while 

rejected records move back to the "Have Attendance" status.  Additional information about the attendance 

process on the Coalition Services Portal is described in this guide. 

Attendance Process - SR 
The provider attendance process is based on reporting exceptions.  SR providers must report absences for enrolled 

children during each service period for each contracted coalition.  Information about the provider’s operational 

schedule and site closures are from the provider’s profile.  Information about paid holidays are from the provider’s 

SR Paid Holidays maintained by the coalition.  Information about the child, such as the child’s name, enrollment 

start and end dates, are from the child’s enrollment record.  Corrections to this information must be made in their 

source areas, not the attendance feature.  Enrollment information is refreshed each time an un-submitted 

attendance roster is opened by the provider.   

Providers record attendance for each day the site is opened and the child is scheduled for service during the child's 

enrollment.  As days occur in the month, they default to present (X).  Providers click on a child’s name and day to 

change the present (X) indicator to absent (A).  A reason for the absence must be selected.  Documentation and a 

note to the coalition are optional.  Non-scheduled days appear as NS on the attendance roster.  If needed, 

providers may change a NS day to present (X) or even absent (A).  Features include a Search button (to search for 

any criteria included in the roster list, such as a name, age, billing group) and a Summary button (to display the 

entire roster in a single month view and print).  
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Attendance Processing 
The Attendance Processing work queues are available under the Reimbursement menu item.  The work queues 

include Need Attendance, Have Attendance, and Closed Attendance. 
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Need Attendance 
The Need Attendance work queue displays all of the outstanding attendance rosters for providers by service 

period and funder type.  Each provider that has an un-submitted attendance record for a child enrollment are 

represented here.  The column filters and search feature may be used to filter the results by specific criteria such 

as a county name or provider name.   

 

Coalition users cannot open or view the attendance rosters from this work queue.  However, whether or not the 

provider has opened or worked on the attendance roster is known by looking at the Action column.  The Action 

column has two indicators:  Missing or Incomplete.  Missing means the provider has not opened the roster.  

Incomplete means the provider has been working on the roster.  In addition, the Last Modified Date and Last 

Modified By information will be populated.  As attendance rosters are submitted, their status changes to Have 

Attendance.  Therefore, they will not be listed in this work queue anymore.  However, if the provider has one or 

more rejected attendance records (from Have Attendance), the service period roster will be listed in the Need 

Attendance work queue again because the provider has outstanding child attendance records that are not yet 

submitted for a service period.  An additional report is available in Tableau with additional information about the 

outstanding child attendance records. 

Have Attendance 
The Have Attendance work queue displays all of the submitted attendance rosters for providers by county and 

funder type.  Each provider that has submitted attendance records for a child enrollment are represented here.  

The column filters and search feature may be used to filter the results by specific criteria such as a county name, 

service period, or provider name.  Attendance rosters submitted after their service period due date are bolded in 

red and have a warning symbol ( ) to indicate their late submission.  Coalitions may choose to work the late 

rosters or skip over them.  Any rosters that do not reach the Paid status when the payment period closes, remain 

in their current status in the new payment period to continue being worked. 
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To begin reviewing submitted attendance records, click on the Review link.  The attendance roster opens.  The top 

portion of the roster contains information about the provider and attendance roster.  The service period, due date, 

and submitted date are displayed.  Again, attendance rosters submitted after their service period due date are 

bolded in red and have a warning symbol ( ) to indicate late submission.   

Each record must have a status of Approved or Rejected in order to continue with the roster processing.  Children 

with 3 or fewer absences default to the Approved status.  Children with 4 or more absences must have the status 

selected.   

Approved records will move forward in the reimbursement process to Closed Attendance.  Rejected records will 

move backward in the reimbursement process to Need Attendance.  Rejecting records is necessary when 

corrections are needed to the child enrollment information, attendance, or schedule (i.e. closures).  Once rejected, 

edits to the enrollment, attendance, and schedule may be updated.  Then, the provider may review and re-submit.  

Rejecting one or more records will not prevent the other approved records from moving forward in the 

reimbursement process. 
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NOTE: For VPK rosters, 1) absences between the anticipated start date and first present day are not reimbursable, 

and 2) absences between the last present day and termination effective date are not reimbursable.  While actual 

absences are recorded in Have Attendance, the system excludes these absences from payment calculations in 

Closed Attendance.    

To reject a single record, click the Reject action button for that row.  A pop-up message appears to collect the 

rejection reason and comment.   

NOTE: The rejection reasons are the same for both SR and VPK programs so they may not be applicable in all cases.  

Selecting "Other" requires a comment.   

 

Once rejected, the child record status and action button change on the roster.  The child record status may be 

changed back to approved by clicking the Approve action button.  Statuses are not committed until the 

Continue/Approve Roster button is selected.  In other words, it will not notify the provider of a rejected record as 

soon as the status is changed on the screen.  There is another step to complete the process before the status is 

committed and notification of rejected records is sent.  

 

When all records have a status, click Continue/Approve Roster.  When rejected records appear, the Continue 

button brings the coalition user to the Complete Roster Processing pop-up message, where the summary is 

displayed and comments are captured for the provider case notes.  When the Complete Roster Processing button 

is clicked, the statuses are committed.  Rejected records are returned to Need Attendance so corrections may be 
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made.  The provider will receive a dashboard notification and the user that submitted the attendance roster will 

receive an email instructing them to log in to the Provider Portal to review and edit the rejected records (indicated 

with "REJ").  The rejected records for the service period move back to Need Attendance.  The approved records for 

the service period move forward to Closed Attendance.   

 

NOTE: It is possible to reject all children on the roster at once by using the Reject All button.  A message appears 

to confirm that the coalition user would like to reject all of the children on the roster and return the roster to the 

provider for editing.  

 

Clicking Yes continues the process.  This gives all records the rejected status.  Next, click the Continue button.  This 

brings the coalition user to the Complete Roster Processing pop-up message, where the summary is displayed and 

comments are captured for the provider case notes.  When the Complete Attendance Processing button is clicked, 

the statuses are committed.  The provider receives notifications and records as moved as described above.    

   

SR & Local rosters in Have Attendance function similarly to VPK in regards to rejecting records, giving each record a 

status, and completing roster processing.  However, there are some differences.  SR & Local rosters include a 

reimbursement code for each absence and display the unit of care per day. 
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As providers record absences on the Provider Portal, the user will select a reason and optionally leave a note or 

upload a document.  The absence information can be viewed in Have Attendance by clicking on the coded 

absence.   

 

 The system will code absences one to three as “E” for excused.  The system will code absences four to seven as 

“A” for authorized.  Absences 11 or more are coded as “N” for non-reimbursable.  Coalition users may override the 

absence code by choosing another reimbursement code (within the system limitations of three E’s and seven A’s) 

and clicking Save.   

Another feature of SR & Local attendance is the ability for providers to change the unit of care on the roster.  This 

feature may be removed at a later time, but in the meantime, if a provider uses the feature the attendance roster 

in Have Attendance highlights the change in red. 
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The unit of care change can be viewed in Have Attendance by clicking on the highlighted value.  A pop-up message 

displays to accept or override the change.   

 

 

Coalition staff can see a quick summary of SR enrollment details in Have Attendance. Click a Child Name link.  

 

After the Child Name link is clicked, the following will display.  
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Closed Attendance 
The Closed Attendance work queue displays all of the approved attendance records for providers by county and 

funder type.  At this point, reimbursement calculations are run.  The School Readiness funder type and Local 

funder type are separated.  The column filters and search feature may be used to filter the results by specific 

criteria such as a county name, service period, or provider name. 

To begin reviewing approved attendance records with reimbursement detail, click on the Review link.  The 

approved attendance records display with calculations.  The top portion of the roster contains information about 

the provider and attendance roster, including whether closures are included and the vendor number for payment.   

 

Similar to Have Attendance, each record in Closed Attendance must have a status of Verified or Adjusted in order 

to continue with the roster processing.   
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Similar to Have Attendance, coalition staff can see a quick summary of SR enrollment details in Closed Attendance. 

Click a Child Name link.  

 

After the Child Name link is clicked, the following will display.  

 

Verified records will move forward in the reimbursement process to Payment Verified.  Adjusted records will move 

to the Need Adjustment work queue for editing.  Marking one or more records for adjustment will not prevent 

the other verified records from moving forward in the reimbursement process. 

An individual record or an entire roster can be sent back to Have Attendance by clicking the Back to “Have” 

button. If the provider needs to make additional changes to the individual record or entire roster, the records can 

be rejected, moving the status back to Need Attendance.  
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NOTE: If any records have CCEP in the Billing Group column, those must be changed to SR Match through the Bulk 

Billing Group Transfer process. See the Bulk Billing Group Transfer section for more details.  

When all records have a status, click Continue.  This brings the coalition user to the Complete Reimbursement 

Processing pop-up message, where the summary is displayed and comments are captured for the provider case 

notes.   

When the Complete Reimbursement Processing button is clicked, the statuses are committed.  

 

Records marked for Adjustment move to the Have Adjustment work queue.  Records marked as Verified move 

forward in the reimbursement process and may be Updated. 

**Printing Tip – An enhancement has been logged to include a print feature as well as a method to recall 

previously worked rosters.  In the meantime, when all records have a status, prior to clicking Continue, follow the 

steps below to select all, copy, and paste the information into an Excel document that can be saved locally.   

1. Click on the webpage (anywhere) 
2. Hold the CTRL key and press A (CTRL + A) 
3. Then, hold the CTRL key and press C (CTRL + C) 
4. Open Excel 
5. Then, in the Excel document, hold the CTRL key and press V (CTRL + V) 
6. Save file locally (remove header/menu information that was included in copy/paste if needed)   
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VPK Calculations in Closed Attendance 

VPK calculations in Closed Attendance are specific to the class calendar and individual enrollment record with 

80/20 included in Hours Paid.   

 Total Instructional Hours are the sum of instructional hours scheduled for the child’s enrollment during 

the service period. 

 Hours Absent and Hours Attended are the sum of instructional hours on the individual days the child 

attended or missed.  Remember, VPK calendars can have variances per day such that most weekdays are 

three hours and one day is four hours (for example).  Therefore, it makes a difference which day the child 

attended or missed.   

 Hours Paid and Amount is the result of the 80/20 calculation as follows:   

 

 Total VPK Instructional Hours (54) x Rate ($4.36) = Maximum Provider Reimbursement ($235.44) 

Bulk1 Attend Total Hours Attended (54) / 0.8 = Hours Paid (84.38) 
Hours Paid > Total Instructional Hours, then use Maximum Provider Reimbursement 

Hours Paid (54) x Rate ($4.36) = Amount ($235.44)  

Bulk2 Attend Total Hours Attended (39) / 0.8 = Hours Paid (48.75) 
Total VPK Instructional Hours (54) – Hours Paid (48.75) = Non-Reimbursable Hours (5.25)  
Non-Reimbursable Hours (5.25) x Rate ($4.36) = 80/20 Adjustment ($22.89) 
Max Provider Reimbursement ($235.44) - 80/20 Adjustment ($22.89) = Amount ($212.55)      

Hours Paid (48.75) x Rate ($4.36) = Amount ($212.55)  

Bulk3 Attend Total Hours Attended (33) / 0.8 = Hours Paid (41.25) 
Total VPK Instructional Hours (54) – Hours Paid (41.25) = Non-Reimbursable Hours (12.75)  
Non-Reimbursable Hours (12.75) x Rate ($4.36) = 80/20 Adjustment ($55.59) 
Max Provider Reimbursement ($235.44) - 80/20 Adjustment ($55.59) = Amount ($179.85)      

Hours Paid (41.25) x Rate ($4.36) = Amount ($179.85)  
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SR Calculations in Closed Attendance 

SR calculations in Closed Attendance are specific to the provider reimbursement rate plan in effect during the 

service period.  To view the provider’s rate plans, click the Provider Rates button. 

 

This opens a new browser tab with the provider’s reimbursement rate plans.  Click on the Reimbursement Rates 

button.  

 

Now, the rates appear. 

 

 Column A represents the provider’s private pay rates (source = Edit Provider Rates). 

 Column B represents the coalition’s maximum reimbursement rates for the provider type and county 
(source = Admin Functions> Rates Management> SR Rate Plans). 
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 Column C represents the approved reimbursement rate (lower of columns A or B) without Gold Seal (or 

other differentials). 

 Column J represents the total payment rate (approved reimbursement rate with Gold Seal and other 

differentials). 

Looking back at the Closed Attendance calculations, coalition users may confirm the rates in use. 

 The Total Payment Rate for each child’s care level and unit of care in Closed Attendance match Column J 

of the provider reimbursement rate plan. 

 The Total Payment Rate multiplied by Days to be Paid equals the Gross Payment Amount. 

 The Daily Parent CoPay Rate multiplied by Days to be Paid equals the Less Parent CoPay Amount. 

 The differential amounts (i.e. Gold Seal Amount, PFP Amount, PFP CA Amount, QI Amount, and CS 

Amount) are already included in the Gross Payment Amount as they are part of the Total Payment Rate, 

however, they can be confirmed by multiplying Days to be Paid and the differential rate on the 

Reimbursement Rate Plan.    

NOTE: If changes to a rate plan are needed there are several options: 

1. Remove a rate plan.  Use the Provider Rates button in Closed Attendance to go to the provider’s 

reimbursement rate plan page.  Then, click the Settings button and Remove button if reimbursement has 

never been processed against the rate plan.  A new reimbursement rate plan can be created.   

2. Edit a rate plan.  Use the Provider Rates button in Closed Attendance to go to the provider’s 

reimbursement rate plan page.  Then, click the Reimbursement Rates button.  Next, click the Edit 

Provider Rates or Edit Differential Rates buttons to make edits if reimbursement has never been 

processed against the rate plan. 

3. End a rate plan and make a new one.  Use the Provider Rates button in Closed Attendance to go to the 

provider’s reimbursement rate plan page.  Then, click the Add Reimbursement Rates button.  Enter the 

start and end date for the new plan and click Save.  Next, click the Reimbursement Rates button to set up 

the plan (by clicking the Edit Provider Rates or Edit Differential Rates buttons).   

Once back in Closed Attendance, click the Refresh Calculations button to update with the new rate plan 

information.   
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Payment Verified Work Queue  
When a record, month (MTH), current period adjustment (MTH), prior period adjustment (PPA), or line item 

adjustment (LIA) is in Payment Verified status for the current payment period, it will display on the Payment 

Verified Work Queue. The Payment Verified Work Queue is only available for the following:  

 For MTH records, selecting the record will move the record back to Closed Attendance 

 For MTH records (current period adjustments), selecting the record will move the record back to Closed 

Attendance and delete the adjustment information 

 For PPA and LIA records, selecting the record will delete the adjustment 

From the Coalition Portal, navigate to Reimbursement > Attendance Processing > View Payment Verified. 

On the Payment Verified Work Queue, select the Funder Type. Clicking the Submit button will display the selected 

funder type’s work queue. 

 

SR  

The search field displays at the top and will filter the work queue based on the information entered. The work 

queue displays 10 records per page by default. The work queue can be changed to display 10, 25, 50, or 100 

records per page. If more than 10 records are available, then pagination is available. The number of entries display 

at the bottom of the work queue. 

Only SR records in Payment Verified status will display in the queue. Clicking on the Select All checkbox will select 

all records on the screen. The following columns display in the work queue: 

 Child Name 

 Provider ID 

 Provider Name 

 Service Period 

 Care Level 

 Unit of Care 

 Billing Group 

 Match Funder ID-Name 

 Match Funder Amount 

 VPK Class ID 

 Enrollment ID 

 Is Adjustment 

 Record Type 

 Reimbursement ID 
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The work queue is sorted alphabetically by Child Name, by default. Each of the columns have a search filter to 

narrow the results. Clicking on a column header will sort the work queue by that criterion. Clicking the Return to 

Search button will navigate to the Payment Verified Work Queue Search screen. Selecting one or more entries and 

clicking on the Run button will do the following: 

 For MTH records, selecting the record will move the record back to Closed Attendance 

 For MTH records (current period adjustments), selecting the record will move the record back to Closed 

Attendance and delete the adjustment information 

 For PPA and LIA records, selecting the record will delete the adjustment 

 

VPK 

The search field displays at the top and will filter the work queue based on the information entered. The work 

queue displays 10 records per page by default. The work queue can be changed to display 10, 25, 50, or 100 

records per page. If more than 10 records are available, then pagination is available. The number of entries display 

at the bottom of the work queue. 

Only VPK records in Payment Verified status will display in the queue. Clicking on the Select All checkbox will select 

all records on the screen. The following columns display in the work queue: 

 Child Name 

 Provider ID 

 Provider Name 

 Service Period 

 Care Level 

 Unit of Care 

 Billing Group 

 Match Funder ID-Name 

 Match Funder Amount 

 VPK Class ID 

 Enrollment ID 

 Is Adjustment 

 Record Type 

 Reimbursement ID 
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The work queue is sorted alphabetically by Child Name, by default. Each of the columns have a search filter to 

narrow the results. Clicking on a column header will sort the work queue by that criterion. Clicking the Return to 

Search button will navigate to the Payment Verified Work Queue Search screen. Selecting one or more entries and 

clicking on Run button will do the following: 

 For MTH records, selecting the record will move the record back to Closed Attendance 

 For MTH records (current period adjustments), selecting the record will move the record back to 

Closed Attendance and delete the adjustment information 

 For PPA and LIA records, selecting the record will delete the adjustment 
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Local 

The search field displays at the top and will filter the work queue based on the information entered. The work 

queue displays 10 records per page by default. The work queue can be changed to display 10, 25, 50, or 100 

records per page. If more than 10 records are available, then pagination is available. The number of entries display 

at the bottom of the work queue. 

Only Local records in Payment Verified status will display in the queue. Clicking on the Select All checkbox will 

select all records on the screen. The following columns display in the work queue: 

 Child Name 

 Provider ID 

 Provider Name 

 Service Period 

 Care Level 

 Unit of Care 

 Billing Group 

 Match Funder ID-Name 

 Match Funder Amount 

 VPK Class ID 

 Enrollment ID 

 Is Adjustment 

 Record Type 

 Reimbursement ID 

The work queue is sorted alphabetically by Child Name, by default. Each of the columns have a search filter to 

narrow the results. Clicking on a column header will sort the work queue by that criterion. Clicking the Return to 

Search button will navigate to the Payment Verified Work Queue Search screen. Selecting one or more entries and 

clicking on the Run button will do the following: 

 Open the Confirm Submit for Reimbursement modal 

 For MTH records, selecting the record will move the record back to Closed Attendance 

 For MTH records (current period adjustments), selecting the record will move the record back to Closed 

Attendance and delete the adjustment information 

 For PPA and LIA records, selecting the record will delete the adjustment 
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Confirmation Modal 
Clicking the Run button will open the Confirm Submit for Reimbursement modal. Clicking the Yes button will close 

the modal and open the Process Complete modal.  

 For MTH records, selecting the record will move the record back to Closed Attendance 

 For MTH records (current period adjustments), selecting the record will move the record back to Closed 

Attendance and delete the adjustment information 

 For PPA and LIA records, selecting the record will delete the adjustment 

Clicking the Cancel button will close the modal and the entries will remain in the Payment Verified Work Queue. 
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Adjustment Processing 

Current Period Adjustments 
Coalitions can create a Current Period Adjustment for any attendance records that have been submitted by a 

provider and approved by the coalition.   

Go to Reimbursement > Attendance Processing > Closed Attendance. Select the Funder Type. Click Submit. 

 

  Current Period Adjustments for SR 
The search results will display all the providers with a status of Closed Attendance. Click the Review link for the 

Service Period.  

 

After clicking on the Review link, the Reimbursement Record for the provider and service period display. Confirm 

that all children on the roster have a status. Click the Adjust button for the selected record. 
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After clicking the Adjust button from the Reimbursement Record, the Current Payment Period Adjustment Needed 

Here pop-up displays.  

Review the Child Name, to ensure this is the correct record to adjust.  Select one or more reasons for the 

adjustment. Enter in a comment. Click on the Move to Have Adjustment button.  

 

The adjusted record now has a status of Adjust, on the Reimbursement Record screen. When all of the records 

have a status, the Continue button will display. Click Continue. 
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After clicking the Continue button, a Reimbursement Processing pop-up will display a summary: 

 Records for Adjustments 

 Records for Reverting 

 Total Verified Record for Final Reimbursement 

 Children needing adjustment 

Review the Child(ren) needing adjustment listed for accuracy. Enter a comment for the provider case note. Click 

Complete Processing. 

 

After clicking Complete Processing, the user returns to the Closed Attendance work queue. 
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After clicking the Review link, the Reimbursement Record for the provider and service period displays. Confirm 

that all children on the roster have a status. Click the Adjust button for the selected record. 

 

After clicking on the Adjust button from the Reimbursement Record, the Current Payment Period Adjustment 

Needed pop-up displays. Review the Child Name, to ensure this is the correct record to adjust. Select one or more 

reasons for the adjustment. Enter a comment. Click on the Move to Have Adjustment button.  
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The adjusted record now has a Status of Adjust, on the Reimbursement Record screen. When all of the records 

have a status, the Continue button will display. Click Continue. 

 

After clicking the Continue button, the Reimbursement Processing pop-up displays a summary: 

 Records for Adjustments 

 Records for Reverting 

 Total Verified Record for Final Reimbursement 

 Children needing adjustment 

Review the Child(ren) needing adjustment listed for accuracy. Enter a comment for the provider case note. Click on 

the Complete Reimbursement Processing button. 

  

After clicking Complete Reimbursement Processing, the user returns to the Closed Attendance work queue. 
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Go to Reimbursement > Adjustment Processing > Have Adjustment to see records marked as needing an 

adjustment. To create a Current Period Adjustment, select a record from the Have Adjustment work queue. Click 

on the Create Adjustment button. 
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After clicking the Create Adjustment button, the Process Reimbursement Adjustment for [ELC Name] pop-up 

displays. The required fields are marked with an asterisk (*). On the Adjustment Information section, it is pre-

populated with the most recent information on the record. The user will need to select the Reason from the 

dropdown menu, and enter a comment. User will click on the Submit button to confirm the adjustment. After the 

adjustment is submitted, it will no longer display in the “Have Adjustment” Work Queue.  

 

The Adjustments Grid has a Balance row with the current balance for the record and an Adjusted row with any 

adjustments made during this edit. In the Adjustments Grid, only the Days to be Paid and Daily Parent CoPay Rate 

are editable. Any changes made that will impact rate (Unit of Care, Care Level, or Daily Parent CoPay Rate) will 

display in the Adjusted row. 
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The column headers in the grid for years 2018-2019 and prior will be: 

 Days to be Paid 

 Total Payment Rate 

 Daily Parent CoPay Rate 

 Gross Payment Amount = [Days to be Paid * Total Payment Rate] 

 Less Parent CoPay Amount = [Days to be Paid * Daily Parent CoPay Rate] 

 Net Payment Amount = [Gross Payment Amount – Less Parent CoPay Amount] 

 Gold Seal Amount = [Days to be Paid * Gold Seal Amount (from SR Rate Plan)] 

 PFP Amount = [Days to be Paid * PFP Amount (from SR Rate Plan)] 

 PFP CA Amount = [Days to be Paid * PFP CA Amount (from SR Rate Plan)] 

 Local QI Amount = [Days to be Paid * Local QI Amount (from SR Rate Plan)] 

 CS Amount = [Days to be Paid * CS Amount (from SR Rate Plan)] 

The column headers in the grid for years 2019-2020 and forward will be: 

 Days to be Paid 

 Total Payment Rate 

 Daily Parent CoPay Rate 

 Gross Payment Amount = [Days to be Paid * Total Payment Rate] 

 Less Parent CoPay Amount = [Days to be Paid * Daily Parent CoPay Rate] 

 Net Payment Amount = [Gross Payment Amount – Less Parent CoPay Amount] 

 Gold Seal Amount = [Days to be Paid * Gold Seal Amount (from SR Rate Plan)] 

 QPI Amount = [Days to be Paid * QPI Amount (from SR Rate Plan)] 

 Child Assessment Amount = [Days to be Paid * Child Assessment Amount (from SR Rate Plan)] 

 Local QI Amount = [Days to be Paid * Local QI Amount (from SR Rate Plan)] 

 CS Amount = [Days to be Paid * CS Amount (from SR Rate Plan)] 
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Current Period Adjustments for VPK 
After marking reimbursement records as needing an adjustment, they will display in the “Have Adjustment” Work 

Queue. To create a Current Period Adjustment, go to Reimbursement > Adjustment Processing > Have Adjustment. 

Select a record from the Have Adjustment Work Queue. Click the Create Adjustment button. 

 

After clicking the Create Adjustment button, the Process Reimbursement Adjustment for [ELC Name] pop-up 

displays. The required fields are marked with an asterisk (*). On the Adjustment Information section, it is pre-

populated with the most recent information on the record. The user will need to select the Reason from the 

dropdown menu, and enter a comment. User will click on the Submit button to confirm the adjustment. After the 

adjustment is submitted, it will no longer display in the “Have Adjustment” Work Queue.  
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In the Adjustments Grid, the Balance row displays the summary of all adjustments for the record. The Adjusted 

row displays any adjustments made during this edit. In the Adjustments grid, the Days Absent, Days Present, Total 

Instructional Hours, Hours Attended fields are editable. 

 

The column headers in the grid are 

 Days Absent 

 Days Present 

 Total Instructional Hours 

 Hours Attended 

 Paid Hours = [(Hours Attended/.8) or Total Instructional Hours] 

 Amount = [(Hours Attended/.8) or Total Instructional Hours] * VPK Rate 

 

Prior Period Adjustments 
Coalitions can create a Prior Period Adjustment (PPA) for any attendance records that have a PAID status. To 

create a PPA, go to Reimbursement > Adjustment Processing > Create Prior Period Adjustment > Create MOD 

Adjustment.  

Create Prior Period Adjustment for SR/Local 
On the Create Period Adjustment for Reimbursement screen, users will enter in criteria to search for paid records 

eligible for a PPA.  
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Only children that have a status of PAID will display in the search results. Click on a record, then click the Create 

Adjustment button. 
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After clicking the Create Adjustment button, the Process Reimbursement Adjustment for [ELC Name] pop-up 

displays. Required fields are marked with an asterisk *. On the Adjustment Information section, it is pre-populated 

with the most recent information on the record. The user will need to select the Reason from the dropdown menu, 

and enter a comment. User will click the Submit button to confirm the adjustment.  

 

In the Adjustments Grid, the Balance row displays the summary of all adjustments/changes for the record. The 

Adjusted row displays any adjustments made during this edit. In the Adjustments grid, only the Days to be Paid and 

Daily Parent CoPay Rate are editable. Any changes made to rate will deduct the amounts, and create a new row in 

the database. Click on the View History button to see the full history of adjustments for the record.  
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The column headers in the grid for years 2018-2019 and prior are: 

 Days to be Paid 

 Total Payment Rate 

 Daily Parent CoPay Rate 

 Gross Payment Amount = [Days to be Paid * Total Payment Rate] 

 Less Parent CoPay Amount = [Days to be Paid * Daily Parent CoPay Rate] 

 Net Payment Amount = [Gross Payment Amount – Less Parent CoPay Amount] 

 Gold Seal Amount = [Days to be Paid * Gold Seal Amount (from SR Rate Plan)] 

 PFP Amount = [Days to be Paid * PFP Amount (from SR Rate Plan)] 

 PFP CA Amount = [Days to be Paid * PFP CA Amount (from SR Rate Plan)] 

 Local QI Amount = [Days to be Paid * Local QI Amount (from SR Rate Plan)] 

 CS Amount = [Days to be Paid * CS Amount (from SR Rate Plan)] 

The column headers in the grid for years 2019-2020 and forward are: 

 Days to be Paid 

 Total Payment Rate 

 Daily Parent CoPay Rate 

 Gross Payment Amount = [Days to be Paid * Total Payment Rate] 

 Less Parent CoPay Amount = [Days to be Paid * Daily Parent CoPay Rate] 

 Net Payment Amount = [Gross Payment Amount – Less Parent CoPay Amount] 

 Gold Seal Amount = [Days to be Paid * Gold Seal Amount (from SR Rate Plan)] 

 QPI Amount = [Days to be Paid * QPI Amount (from SR Rate Plan)] 

 Child Assessment Amount = [Days to be Paid * Child Assessment Amount (from SR Rate Plan)] 

 Local QI Amount = [Days to be Paid * Local QI Amount (from SR Rate Plan)] 

 CS Amount = [Days to be Paid * CS Amount (from SR Rate Plan)] 
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After clicking the View History button, in the below example, the Adjustments History grid shows that this record 

has had one adjustment saved. The amounts deducted display in red text. The Adjustments History is sorted by 

Reimbursement Detail ID (oldest to newest). The Total row displays the calculated amounts based on all 

adjustments. The Total row information is also what displays in the Balance row on the Adjustments grid.  
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Create Prior Period Adjustment for VPK 
After clicking the Create Adjustment button, the Process Reimbursement Adjustment for [ELC Name] pop-up 

displays. Required fields are marked with an asterisk *. On the Adjustment Information section, it is pre-populated 

with the most recent information on the record. The user will need to select the Reason from the dropdown menu, 

and enter a comment. User will click the Submit button to confirm the adjustment.  

 

 

In the Adjustments Grid, the Balance row displays the summary of all adjustments for the record. The Adjusted 

row displays any adjustments made during this edit. In the Adjustments grid, the Days Absent, Days Present, Total 

Instructional Hours, Hours Attended fields are editable. Click the View History button to see the full history of 

adjustments for the record.  

The column headers in the grid are: 

 Days Absent 

 Days Present 

 Total Instructional Hours 

 Hours Attended 

 Paid Hours = [(Hours Attended/.8) or Total Instructional Hours] 

 Amount = [(Hours Attended/.8) or Total Instructional Hours] * VPK Rate 
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After clicking the View History button, in the below example, the Adjustments History grid shows that this record 

has had multiple adjustments saved. The Adjustments History is sorted by Reimbursement Detail ID (oldest to 

newest). The Total row displays the calculated amounts based on all adjustments. The Total row information is also 

what displays in the Balance row on the Adjustments grid.  

The column headers in the Adjustments History grid are: 

 Days Absent 

 Days Present 

 Total Instructional Hours 

 Hours Attended 

 Paid Hours = [(Hours Attended/.8) or Total Instructional Hours] 

 Amount = [(Hours Attended/.8) or Total Instructional Hours] * VPK Rate 
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Line Item Adjustments (LIA) 
Coalitions can create Line Item Adjustments (LIA) for a reimbursement record. The LIA can add or create a new 

record, which may or may not be EFS Mod-generated records. Adjustments can add a new entry or reverse out an 

entry.  

SR or Local Line Item Adjustments 
To create a Line Item Adjustment, navigate to Reimbursement > Adjustment Processing > Create Line Item 

Adjustment > SR/Local  

Any saved line item adjustments will be processed in the currently open payment period.  

Required fields are marked with an asterisk *. A record does not have to be in EFS Mod to create a line item 

adjustment. Clicking the Submit button will open the SR Line Item Adjustment modal.  

 

Search  

Before creating a Line Item Adjustment, search using the Reimbursement Detail ID or the Enrollment ID. 

Reimbursement Detail ID is available on the 5045 detail download.  

Enter the Reimbursement Detail ID and click on the search icon  to populate the record with the available 

information: 

 Service Period Month 

 Service Period Year 

 Provider ID 

 Name of Provider 

 Principal ID 

 Name of Principal 

 Vendor ID 

 Provider Type 

 Provider County 

 Child ID 

 Name of Child 

 Name of Parent 

 County of Parent 

 Enrollment ID (dropdown selection of available enrollment dates) 

 Purpose of Care 

 Funding Type 
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 Unit of Care 

 Billing Group 

 Eligibility 

 Care Level  

 Days to be Paid 

 Total Payment Rate 

 Match Amount 

The Enrollment ID can be found on the Eligibility screen. Enter the Enrollment ID and click on the search icon  to 

populate the record with the available information: 

 Service Period Month 

 Service Period Year 

 Provider ID 

 Name of Provider 

 Principal ID 

 Name of Principal 

 Vendor ID 

 Provider Type 

 Provider County 

 Child ID 

 Name of Child 

 Name of Parent 

 County of Parent 

 Enrollment ID 

 Purpose of Care 

If a search result is not found, then the Adjustment Search modal opens. Clicking on the OK button will close the 

Adjustment Search modal.  

 

If the Reimbursement Detail ID or Enrollment ID are not known, then enter the Service Period Month and Service 

Period Year. The Service Period Year must be between 1990 and the current year. Select the Adjustment Reason 

from the dropdown menu. Select Restitution if the LIA will have a Service Period prior to 7/1/2018. 
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Provider (Payee) Information  

Service Period After 7/1/2018 

Required fields are marked with an asterisk *. If the Service Period is 7/1/2018 or after, then the Provider ID search 

will be available, see the screen below. If the Service Period is prior to 7/1/2018, then the Provider ID will not be 

required. If the Reimbursement Detail ID or Enrollment ID are entered in the search at the top of the screen, then 

Provider Information will pre-populate.  

 

Service Period Prior to 7/1/2018 

Required fields are marked with an asterisk *. If the Service Period is prior to 7/1/2018, then the Provider ID search 

will not be available, see the screen below. If the Service Period is prior to 7/1/2018 and the Adjustment Reason is 

Restitution, then the Provider ID will not be required. 

The Name of Provider is a text field. If a Provider ID is entered, it must match a current Provider ID in EFS Mod. If 

the Provider ID does not match a current Provider ID in EFS Mod, then the LIA will not save.  

The Name of Principal is a text field. If a Principal ID is entered, it must match a current Principal ID in EFS Mod. If 

the Principal ID does not match a current Principal ID in EFS Mod, then the LIA will not save. 

The Vendor ID is an alphanumeric field. The Vendor ID is the Taxpayer ID Number, which can be found on the 

Provider’s Business Info screen. 

The Provider Type dropdown field displays the available Provider Types.  

The Provider County dropdown displays all Florida counties.  
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Parent & Child Information 

Service Period After 7/1/2018 

Required fields are marked with an asterisk *. If the Service Period is 7/1/2018 or after, then the Child ID search 

will be available, see the screen below. If the Service Period is prior to 7/1/2018, then the Child ID will not be 

required. If the Reimbursement Detail ID or Enrollment ID are entered in the search at the top of the screen, then 

Parent & Child Information will pre-populate. The Enrollment ID will be a dropdown menu and display any 

enrollment dates the child was enrolled.  

 

Service Period Prior to 7/1/2018 

Required fields are marked with an asterisk *. If the Service Period is prior to 7/1/2018, then the Child ID search 

will not be available, see the screen below. If the Service Period is prior to 7/1/2018 and the Adjustment Reason is 

Restitution, then the Child ID will not be required. 

The Name of Child is a text field.  

The Name of Parent is a text field. 

The County of Parent dropdown displays all Florida counties.  

If an Enrollment ID is entered, it must match a current Enrollment ID in EFS Mod. If the Enrollment ID does not 

match a current Enrollment ID in EFS Mod, then the LIA will not save. 

The Purpose of Care dropdown field displays the available Purposes of Care.  
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Adjustment Information 

Service Period After 7/1/2018 

Required fields are marked with an asterisk *. If the Reimbursement Detail ID or Enrollment ID are entered in the 

search at the top of the screen, then Adjustment Information will pre-populate.  

The Funding Type dropdown field displays the available Funding Types (SR or Local). 

The Service Period Month dropdown field displays the available Months.  

The Service Period Year is a numeric field. Users can save entries between 1990 and the current year.  

The Unit of Care dropdown field displays the available Units of Care.    

The Billing Group dropdown field displays the available Billing Groups.  

The Eligibility dropdown field displays the available Eligibility.  

The Care Level dropdown field displays the available Care Levels.  

The Match Funder dropdown field displays available Match Funders.  

The Days to be Paid can be a positive or negative number. The Days to be Paid cannot be 0.  

The Total Payment Rate is the daily payment rate. The Total Payment Rate must be between $0.00 and $100.00.  

The Daily Parent CoPay Rate must be greater than or equal to $0.00. 

The Gross Payment Amount is a calculated field. [Total Payment Rate * Days to be Paid] 

The Less Parent CoPay Amount is a calculated field. [Daily Parent CoPay Rate * Days to be Paid] 

The Net Payment Amount is a calculated field. [Gross Payment Amount – Less Parent CoPay Amount} 

The Match Amount is the amount paid by a Match. 

The Net Less Match is a calculated field. [Net Payment Amount – Match Amount] 

The differentials grid will allow the entry of any adjustments for the following: 

a. 2018-2019 and Prior Years 

i. Gold Seal Amount 

ii. PFP Amount 

iii. PFP CA Amount 

iv. QI Amount 

v. CS Amount 

b. 2019-2020 and Future Years 

i. Gold Seal Amount 

ii. QPI Amount 

iii. Child Assessment Amount 

iv. Local QI Amount 

v. CS Amount 

For 2019-2020 and future years, the differentials have under and over fields.  

The Comments field is a text field.  
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Service Period prior to 7/1/2018 

Required fields are marked with an asterisk *.  

The Omit from Transmittal File will default to Yes for legacy LIA records.  

The Funding Type dropdown field displays the available Funding Types (SR or Local). 

The Service Period Month dropdown field displays the available Months.  

The Service Period Year is a numeric field. Users can save entries between 1990 and the current year.  

The Unit of Care dropdown field displays the available Units of Care.    

The Billing Group dropdown field displays the available Billing Groups.  

The Eligibility dropdown field displays the available Eligibility.  

The Care Level dropdown field displays the available Care Levels.  

The Match Funder dropdown field displays available Match Funders.  
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The Days to be Paid can be a positive or negative number. The Days to be Paid cannot be 0.  

The Total Payment Rate is the daily payment rate. The Total Payment Rate must be between $0.00 and $100.00.  

The Daily Parent CoPay Rate must be greater than or equal to $0.00.  

The Gross Payment Amount is a calculated field. [Total Payment Rate * Days to be Paid] 

The Less Parent CoPay Amount is a calculated field. [Daily Parent CoPay Rate * Days to be Paid] 

The Net Payment Amount is a calculated field. [Gross Payment Amount – Less Parent CoPay Amount} 

The Match Amount is the amount paid by a Match. 

The Net Less Match is a calculated field. [Net Payment Amount – Match Amount] 

The differentials grid will allow the entry of any adjustments for 

a. 2018-2019 and Prior Years 

i. Gold Seal Amount 

ii. PFP Amount 

iii. PFP CA Amount 

iv. QI Amount 

v. CS Amount 

b. 2019-2020 and Future Years 

i. Gold Seal Amount 

ii. QPI Amount 

iii. Child Assessment Amount 

iv. Local QI Amount 

v. CS Amount 

For 2019-2020 and future years, the differentials have under and over fields.  

The Comments field is a text field.  
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Confirmation Modal 

Clicking the Yes button will save the adjustment and open the Line Item Adjustment modal. Clicking the Cancel 

button will discard any changes and close the modal. 

 

Clicking the OK button will close the Line Item Adjustment modal. 
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VPK Line Item Adjustments 
To create a Line Item Adjustment, navigate to Reimbursement > Adjustment Processing > Create Line Item 

Adjustment > VPK  

Any saved line item adjustments will be processed in the currently open payment period. Required fields are 

marked with an asterisk *. A record does not have to be in EFS Mod to create a line item adjustment. Clicking the 

Submit button will open the Confirm Submit VPK Line Item Adjustment modal.  

 

Search  

Before creating a Line Item Adjustment, search using the Reimbursement Detail ID or the Enrollment ID. 

Reimbursement Detail ID is available on the 5045 detail download. 

Enter the Reimbursement Detail ID and click on the search icon  to populate the record with the available 

information: 

 Service Period Month 

 Service Period Year 

 Provider ID 

 Name of Provider 

 Principal ID 

 Name of Principal 

 Vendor ID 

 Provider Type 

 Provider County 

 Child ID 

 Name of Child 

 Name of Parent 

 County of Parent 

 Class Name 

 Billing Group 

 Hourly Payment Rate 
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 Total Instructional Hours 

 Hours Attended 

The Enrollment ID can be found on the Eligibility screen. Enter the Enrollment ID and click on the search icon  to 

populate the record with the available information: 

 Service Period Month 

 Service Period Year 

 Provider ID 

 Name of Provider 

 Principal ID 

 Name of Principal 

 Vendor ID 

 Provider Type 

 Provider County 

 Child ID 

 Name of Child 

 Name of Parent 

 County of Parent 

 Class Name 

If a search result is not found, then the Adjustment Search modal opens. Clicking on the OK button will close 

the Adjustment Search modal.  

 

If the Reimbursement Detail ID or Enrollment ID are not known, then enter the Service Period Month and Service 

Period Year. The Service Period Year must be between 1990 and the current year.  

Select the Adjustment Reason from the dropdown menu. Select Restitution if the LIA will have a Service Period 

prior to 7/1/2018. 
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Provider (Payee) Information  

Service Period After 7/1/2018 

Required fields are marked with an asterisk *. If the Service Period is 7/1/2018 or later, then the Provider ID search 

will be available, see the screen below. If the Service Period is prior to 7/1/2018, then the Provider ID will not be 

required. If the Reimbursement Detail ID or Enrollment ID are entered in the search at the top of the screen, then 

Provider Information will pre-populate.  

 

Service Period Prior to 7/1/2018 

Required fields are marked with an asterisk *.  

The Name of Provider is a text field. 

The Name of Principal is a text field. If a Principal ID is entered, it must match a current Principal ID in EFS Mod. If 

the Principal ID does not match a current Principal ID in EFS Mod, then the LIA will not save. 

The Vendor ID is an alphanumeric field. The Vendor ID is the Taxpayer ID Number, which can be found on the 

Provider’s Business Info screen. 

The Provider Type dropdown field displays the available Provider Types. 

The Provider County dropdown displays all Florida counties. 

 

Parent & Child Information 

Service Period After 7/1/2018 

Required fields are marked with an asterisk *.  If the Service Period is 7/1/2018 or after, then the Child ID search 

will be available, see the screen below. If the Service Period is prior to 7/1/2018, then the Child ID will not be 

required. 

If the Reimbursement Detail ID or Enrollment ID are entered in the search at the top of the screen, then Parent & 

Child Information will pre-populate. 

If a Child ID is entered, it must match a current Child ID in EFS Mod. If the Child ID does not match a current Child 

ID in EFS Mod, then the LIA will not save. 

The Class Name is limited to 4 characters (e.g. AF17). 
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Service Period Prior to 7/1/2018 

Required fields are marked with an asterisk *.  

The Name of Child is a text field.  

The Name of Parent is a text field. 

The Class Name is limited to 4 characters (e.g. AF17). 

 

Adjustment Information 

Required fields are marked with an asterisk *.  

The Adjustment Reason dropdown field displays the available Adjustment Reasons.  

The Billing Group dropdown field displays the available Billing Groups.  

The Hourly Payment Rate is the reimbursement hourly rate.  

The Days Absent is an optional field.  

The Days Present is an optional field.  

The Total Instructional Hours is the total hours available for the month.  

The Hours Attended is the amount of hours the child attended class. If there are closure days, then include those 

hours to the Hours Attended. The Hours Attended cannot be 0. The Hours Attended can be a positive or negative 

number.  

The Paid Hours is a calculated field, which includes 80/20. 

The Amount is a calculated field, which includes 80/20. 

The Comments field is a text field.  
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Confirmation Modal 
Clicking the Yes button will save the adjustment and open the Line Item Adjustment modal. Clicking the Cancel 

button will discard any changes and close the modal.  

 

Clicking on the OK button will close the Line Item Adjustment modal. 
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Scenarios - Adjustment Fixes Needed 
Below are some scenarios that a Coalition may encounter.   

 

Wrap rate paid is double 

If a duplicate record was paid, and days of the payment need to be reversed for a service period.  

SR or Local 
Create a LIA, by entering all the required fields and enter a negative number for the Days to be Paid, enter the 

Total Payment Rate, and enter the Daily Parent CoPay Rate, if applicable. If there are differentials that were 

included, then include those details in the LIA.  

VPK 
Create a LIA, by entering all the required fields and enter the Hourly Payment Rate, applicable for the year to be 

adjusted, enter the Total Instructional Hours for the service period month, and enter a negative number in the 

Hours Attended. 

Split Unit of Care or Care Level 

A child was paid for all of August 2018 (23 days) at the PR5/FT rate but should have been SCH once school began. 

The child needs reimbursement for 8 days at the PR5/FT rate. The child needs reimbursement for 15 days at the 

SCH/PT rate. 

SR or Local 
Create a prior period adjustment on the paid August 2018 record to reduce the 23 PR5/FT days to 8 PR5/FT days 

(net – 15 PR5/FT days). Create a LIA for the remaining 15 days at the SCH/PT rate. Enter all the required fields – 

enter in the related child and provider information, select “PT” for the Unit of Care, select “In School” for the Care 

Level, enter 15 for Days to be Paid, and enter the Total Payment Rate for the daily payment rate. 
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Bulk Billing Group Transfer 
Coalitions now have the opportunity to apply for and receive from the state a match allocation based on a dollar 

for dollar match. Once awarded, the match allocation can be applied at the participant level in the manner 

determined by the coalition to represent the most efficient expenditure of the coalition’s awarded SR dollars. In 

order to access the awarded match dollars, coalitions should invoice OEL through the BG8 SRMAT eligibility code 

and should expect to receive the amount equal to the local match received to complete the balance of the 

monthly payment. Coalitions should not invoice OEL for any records that include CCEP for any period in the 2019 

2020 fiscal year.  

In an attempt to assist coalitions through the transition of the match process, OEL developed a bulk billing group 

transfer tool within EFS Mod that allows coalition to transfer records, on a monthly basis, to the appropriate 

category to best utilize the needed match for that payment period. This tool was provided to allow coalitions 

additional time to make eligibility and enrollment changes to child records, as needed, to accurately reflect the 

actual match application. The tool only makes the changes for the current month and for payment purposes 

only. If eligibility and enrollment data is not made at the child level, the tool would need to be used again in the 

next month to accurately assess the match as determined by the coalition. This process would continue until the 

eligibility and enrollment records were changed at the child level. 

Beginning with the July 2019 service period, children with the CCEP match billing group must be updated with the 

Bulk Billing Group Transfer feature while in Closed Attendance to an appropriate billing group. Children eligible for 

the new SR Match program need to be updated with the Bulk Billing Group Transfer feature so that their billing 

group is BG8 and their eligibility code is SR MATCH, provided that the coalition has SR Match funds to use. This will 

apply a 50% default match assessment calculation that can be increased, decreased, or zeroed out with the Run 

Match Assessment feature, if needed, as determined by the coalition. This also associates the records to the new 

SR Match OCA Payment Code, SRMAT. Children may remain in the BG8 billing group with the ECON eligibility code.  

With the release of 4.1.6, the default match assessment calculation will be 0%. The calculation can be increased, as 

needed, using the Run Match Assessment feature. This associates the records to the current 97P00 OCA Payment 

Code. Separate match funding agencies and allocation plans for BG8 ECON and BG8 SRMAT must be created. 

NOTE: This process is a temporary solution required each service period until new match funders are created and 

enrollment records are updated. 

SR Match Funder Allocation for BG8-SRMAT 
To use the BG8 SRMAT eligibility code, a new BG8 match funder must be set up. Go to Maintenance > Local 

Funding > Local Funding Agencies. 
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Make sure that a SRMAT funder is created with an allocation. 

 

 

If no BG8 SRMAT funder exists, click the Create Local/Match Funding Agency button and complete the required 

fields.  
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Locate the newly created funding agency. Check the View Allocations box and click the View Funding Allocation 

button. 

 

If no BG8 SRMAT allocation exists, click the Create New Local Funding Allocation button. 

 

Complete the required fields. 
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SR Match Program Changes for 2019-2020 
Go to Maintenance > Local Funding > Local Funding Agencies > Edit Agency. 

 

For Local Funding, the same questions for CCEP will display for BG8. CCEP can only have a start date prior to July 1, 

2019. 

 Federally Eligible 

 Match Funding Type 

 Business Type 
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Funding Allocation 
After creating a new Local/Match Funding Agency, click the View Allocations checkbox. Then click the View 

Funding Allocation button. 

 

Create New Local Funding Allocation 
Clicking the Create New Local Funding Allocation button will open the Local Funding Allocation – Edit Record 

screen. 
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Local Funding Allocation – Edit Record 

For BG8 records, the Match Percent defaults to 50%. The Begin Date can only be on the first day of the month. If a 

date other than the first day of the month, clicking the Save button will change the date to the first day of the 

month. The End Date can only be the last day of the month. If a date other than the last day of the month, clicking 

the Save button will change the date to the last day of the month.  
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Closed Attendance Check 
Once the new funder and funding allocations are created, at the end of the payment period, go to Reimbursement 

> Attendance Processing > Closed Attendance. 

 

Select the Funder Type (SR) from the funder type drop down menu and click Submit. Then, click on the Review link 

to open a provider’s Closed Attendance records for a service period. 

 

Review the records. Are there are CCEP records? If so, STOP! 

 

The CCEP records must be changed with the bulk billing group transfer process before verifying.  

Go to the Reimbursement menu and select Reimbursement Closeout > Bulk Billing Group Transfer. 
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The results display all records in Closed Attendance that have the funder type, billing group, and eligibility 

combination for the service period selected. Use the Search feature and column filters to narrow results. Scroll to 

the right to see more. 
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Select each row that needs to be updated by clicking the row. The row becomes highlighted blue and the total 

number of rows selected display at the bottom of the screen. Click the Update button. 

 

The Update Billing Group Assignments pop-up displays. The Current Information area displays the current funder 

type, billing group, eligibility code and match funder name. Coalition users input the changes needed in the New 

Information area. Then, click the Run button. 
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The Results window displays a preview of the updated reimbursement records. Notice the changed billing group, 

eligibility code. If correct, click the Save button. Otherwise, click the Cancel button to abandon the changes. 

 

Next, a confirmation message displays. Click the Yes button to commit the changes. Otherwise, click the Cancel 

button to abandon the changes. 

 

Then, a success message displays with the total number of records that were updated. Click the OK button. 

 

When the message is closed, the screen returns to the Bulk Billing Group Transfer search page. The changes can 

now be verified in Closed Attendance. 
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Review the records. Now that there are no CCEP records, continue to verify records as usual. Repeat for all service 

period rosters. 
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Reimbursement Closeout Process  
The Reimbursement Closeout features are available under the Reimbursement menu item.  The features included 

in Reimbursement Closeout are Run Reimbursement Report, Run Match Assessment, Run 5045 Report, Run 

Update Process, Run Payment Transmittal File, and Review & Close Payment Period.   

 

Run Reimbursement Report  
Navigate to the Reimbursement Closeout > Run Reimbursement Report page.  Click the Run Reimbursement 

Report button from the appropriate funder type row.   
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A pop-up message appears to collect the report parameters.  The Trial Reimbursement Report includes records 

that are in Closed Attendance and Payment Verified statuses for the payment period and funder type selected.  

The Final Reimbursement Report includes records that are in Updated and Paid statuses for the payment period 

and funder type selected.  

 

To print a PDF of the report, click on the PDF Reports icon.  Allow the print menu to display.  Hover over the Get 

Provider Reimbursement PDF link and click on it.  The PDF report will open. 
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Run Match Assessment  
Prior to July 1, 2019 the state required 6% local match participation for BG8 families and a 50% local match for 

participants in the Child Care Executive Partnership (CCEP) program. The significant change in match for 2019 2020 

is that now there is no requirement for local match at the coalition level for BG8 eligible families and the CCEP 

program no longer exists.  

The match assessment process must be run when all service period records are in Payment Verified status. Go to 

Reimbursement > Reimbursement Closeout > Run Match Assessment.  

 

Select the required fields and click the Update button.  

 

After clicking Update, a Confirm Update Match Funding pop-up displays. Click the Yes button to confirm. Then, the 

page refreshes with the assessed match amount. 
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This can be run again. This time, try a dollar amount. 

 

The same can be done for BG8 SRMAT. 
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NOTE: All match assessment runs must be complete prior to initiating the Run Update process.  The Run Update 

process will change the record status to Updated, locking in the payment amounts.  Match assessment can only be 

run on records in the Payment Verified status.  The amounts in place when the Run Update process runs is the final 

match assessment.  The Match Funder Report is available in Tableau. 

Run Update  
To begin the process, go to the Reimbursement menu item.  Select Reimbursement Closeout> Run Update 

Process.  Click the Run Update button for the appropriate funder type.  The Run Update process completes and 

the total number of records move from the Payment Verified column to the Updated column.  

  Run Payment Transmittal File 
Go to the Reimbursement menu item.  Select Reimbursement Closeout> Run Payment Transmittal File.  Click the 

Run File button for the appropriate funder type.  A pop-up message appears.  The Payment Transmittal File default 

criteria is set: 

 Payment Period is the current payment period 

 Summarization Option of Group by Billing Group 

 Included Records Option is Updated Records Only 

An Excel file downloads and the total number of records move from the Updated column to the Paid column. Click 

Run Transmittal file. The file downloads and the total number of records display in the Paid column.     

 

 

 

 

 

 

 

 

 

Run 5045 Report  
Navigate to the Reimbursement Closeout> Run 5045 Report page.  Click the Run 5045 Report button from the 

appropriate funder type row.  A pop-up message appears to collect the report parameters.  The Trial 

Reimbursement Report includes records in all statuses for the payment period and funder type selected.  The Final 

Reimbursement Report includes records that are in Updated and Paid statuses for the payment period and funder 

type selected. To print a PDF of the report, click on the PDF Reports icon.  Allow the print menu to display.  Hover 

over the Get Provider Reimbursement PDF link and click on it.  The PDF report will open. 
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VPK Advance Payment Process 
VPK providers that indicate participation in advance payment (through their Profile> General tab) are included in 

the VPK Advance Payment process.   

Run Update (Part 1 - Trial) 
To begin the process, go to the Reimbursement menu item.  Select Reimbursement Closeout> Run Update 

Process.  Go to the VPK Advance – VPK row and click Run Update. 

 

A pop-up message appears.  The service period displays at the top and payment information for each VPK provider 

class (with advance payment) displays below.   

 

a. Total Payment = VPK Hourly Rate x .95 (rounded to the penny) x Total Hours Paid.   

b. The service period for advance payment is set one month ahead of the current payment period.  

For example, if the current payment period is August, the service period is October. 

c. The provider's class calendar and each child's enrollment record is used to calculate the Total 

Hours Paid for the service period. 

d. Providers with fewer than four child enrollments cannot start a class so they are excluded from 

advance payment.  When the condition is met, the class is included.  NOTE: After the initial 

requirement to start the class is met, the enrollment number may be lower and still be included 

in the reimbursement process.  
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STOP!  Click Cancel.  (Clicking Accept completes the Run Update and locks the payment.  To see a Trial 5045 and 

Detail Report BEFORE completing the Update process, click Cancel.) 

Click the refresh button on your browser or CTRL + F5.  The total number of records display in the Payment Verified 

column.  

 

Run Trial 5045 Report  
Next, go to the Reimbursement menu item.  Select Reimbursement Closeout> Run 5045 Report.  Go to the VPK 

Advance – VPK row and click Run 5045 Report.  

 

A pop-up message appears.  Click Run Trial 5045 Report.   

 

The Trial Advance Payment Summary Report opens.   

a. A detail report (with child information) is available by selecting Detail Report. 

b. To print, click the Download button on the bottom right corner of the screen.  A download pop-

up message displays.  Select PDF, change the paper orientation to Landscape, and click Create 

PDF.  When the PDF file is generated, click Download.  The file may be saved locally. 



 300 

Run Update (Part 2 - Commit) 
Go to the Reimbursement menu item.  Select Reimbursement Closeout> Run Update Process.  Go to the VPK 

Advance – VPK row and click Run Update. 

 

A pop-up message appears.  Click Accept.  The Run Update process completes and the total number of records 

display in the Updated column.  

 

Run Payment Transmittal File 
Go to the Reimbursement menu item.  Select Reimbursement Closeout> Run Payment Transmittal File.  Go to the 

VPK Advance – VPK row and click Run File.  
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A pop-up message appears.  The Payment Transmittal File default criteria is set.  Click Run Transmittal File.       

 

The file downloads and the total number of records display in the Paid column.   

 

Save the downloaded file locally.  See Payment Transmittal File Layout below. 

Run Final 5045 Report  
Go to the Reimbursement menu item.  Select Reimbursement Closeout> Run 5045 Report.  Go to the VPK 

Advance – VPK row and click Run 5045 Report.  
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A pop-up message appears.  Click Run Final 5045 Report.   

 

The Final Advance Payment Summary Report opens.   

a. A detail report (with child information) is available by selecting Detail Report 

b. To print, click the Download button on the bottom right corner of the screen.  A download pop-

up message displays.  Select PDF, change the paper orientation to Landscape, and click Create 

PDF.  When the PDF file is generated, click Download.  The file may be saved locally. 
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VPK Specialized Instructional Service (SIS) Process 
VPK SIS providers may be paid through the Coalition Services Portal by enrolling and building a schedule of services 

for a child.  To use this feature, users must be Coalition Admin or Coalition User with "Manage Reimbursements" 

permissions.  In addition, VPK SIS Providers for each coalition must be created and the VPK child application must 

be approved with a SIS session type.   

Add VPK SIS Provider 
VPK SIS providers do not require a traditional provider profile or document submission.  An administrative page is 

currently being developed to allow coalition staff to enter abbreviated profile information for VPK SIS providers.  In 

the meantime, coalition staff are asked to submit a spreadsheet with the following information for each VPK SIS 

provider. Please contact the Service Desk at Service.Desk@oel.myflorida.com to get a copy of the provider 

submission spreadsheet, then submit the completed spreadsheet to the Service Desk.  

 

 

mailto:Service.Desk@oel.myflorida.com
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Locate VPK Child Application with SIS Session Type 
To begin, locate the VPK child application in need of enrollment.  Go to the VPK Program menu item.  Select VPK 

Application > Search.   

 

VPK Application Search page displays.  Select Program Year and VPK Session> School-year Specialized Instructional 

Service (SIS) or Summer Specialized Instructional Service (SIS).  Click the Search button.  Results display.  The child’s 

COE number, first name, last name, and date of birth are needed for enrollment.   

a. If a child’s application has the incorrect session type, it may be re-opened to have the session 

type changed. 
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Enroll VPK SIS Child/Build Schedule of Services 
Next, go to the Reimbursement menu item.  Select VPK Reimbursement Tools > Manage VPK SIS Invoice.   

 

Invoice page displays.  Enter the Certificate Number (VPK#####-YYYY), Child First Name, Child Last Name, and Child 

Date of Birth.  Click the Search button.  

 

a. Message "Child not found." = Re-enter the information because no matching child information 

was located. 

b. Message "Child is not eligible to receive VPK SIS services.  Please review the application." = Child's 

VPK application was not approved for a VPK SIS session. 

c. Message "Child is not enrolled in VPK SIS.  Please enroll the child." = Continue to enroll the child.   

 

Click the Enroll Child button.  The child and program information displays.  The VPK SIS Appointment button 

becomes enabled.   

NOTE: The date of the IEP will not be populated until a future enhancement.  Total available funding reflects the 

maximum provider payment for the county on VPK Max Rates.  Click the VPK SIS Appointment button.   
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A pop-up message displays to add the VPK SIS appointment. 

 

a. Type SIS provider name in field and click Search.  

i. If provider is missing, please contact service.desk@oel.myflorida.com to submit provider 

information.   

b. Click on the SIS provider name so that it is highlighted. 

c. Enter SIS appointment date, time, and cost.  Click the Save button.   

Pop-up message closes.  Appointment details display.  Cost for service is deducted from the total available funding.  

Reviewed By information displays.  Remove and Verify Payment buttons are enabled.  Remaining Funding is 

updated.  

 

a. Saved appointments with incorrect information may be removed and re-added with corrections.  

NOTE: Once a payment is verified, the appointment cannot be removed. 

b. Repeat as needed to save more appointments.  Cost for services cannot exceed the remaining 

funding. 
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Manage VPK SIS Invoice and Verify Payment 
Go to the Reimbursement menu item.  Select VPK Reimbursement Tools > Manage VPK SIS Invoice.  Invoice page 

displays.  Enter the Certificate Number (VPK#####-YYYY), Child First Name, Child Last Name, and Child Date of 

Birth.  Click the Search button.  The saved child enrollment and Schedule of Services display. 

To initiate payment, check off the Parent’s Initials box.  The SIS appointment date populates in the Date SIS 

Received field; however, it may be edited if the appointment date changed.   

 

a. Checking the Parent’s Initials box is required.  A payment cannot be verified without this check 

box. 

b. NOTE: This is the last opportunity to remove the appointment if corrections are needed.  Once a 

payment is verified, the appointment cannot be removed. 

Click the Verify Payment button.  Payment submitted by and date/time displays.  This record now appears in the 

Payment Period Summary in the Payment Verified column. 

 



 308 

Run Update 
Go to the Reimbursement menu item.  Select Reimbursement Closeout > Run Update Process.  Go to the VPK SIS 

row and click the Run Update button.  The total number of records display in the Payment Cycle Summary 

Updated column. 

Run Payment Transmittal File 
Go to the Reimbursement menu item.  Select Reimbursement Closeout > Run Payment Transmittal File.  Go to 

the VPK SIS row and click the Run File button.  A pop-up message appears.  The Payment Transmittal File default 

criteria is set.  Click Run Transmittal File.  The file downloads and the total number of records display in the 

Payment Cycle Summary Paid column.  Save the downloaded file locally.   

Run Trial/Final Reimbursement Report  
Go to the Reimbursement menu item.  Select Reimbursement Closeout> Run Reimbursement Report.  Go to the 
VPK SIS row and click the Run Reimbursement Report button.  A pop-up message appears.  Click the Run Trial 
Reimbursement Report button or Run Final Reimbursement Report button.  The Provider Reimbursement Report 
opens.   

a. A detail report (with child information) is available by selecting Detail Report 
b. To print, click the Download button on the bottom right corner of the screen.  A download pop-

up message displays.  Select PDF, change the paper orientation to Landscape, and click Create 

PDF.  When the PDF file is generated, click Download.  The file may be saved locally. 

Run Trial/Final 5045 Report  
Go to the Reimbursement menu item.  Select Reimbursement Closeout> Run 5045 Report.  Go to the VPK SIS row 
and click the Run 5045 Report button.  A pop-up message appears.  Click the Run Trial 5045 Report button or Run 
Final 5045 Report button.  The 5045 Report opens.   

a. A detail report (with child information) is available by selecting Detail Report 
b. To print, click the Download button on the bottom right corner of the screen.  A download pop-

up message displays.  Select PDF, change the paper orientation to Landscape, and click Create 
PDF.  When the PDF file is generated, click Download.  The file may be saved locally. 
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Temporary Closures and Emergency Closures 

 Creating Provider Closures 
Unexpected site closures must be entered by the coalition in order to appear as reimbursable (or not) on the 

provider's attendance roster.  To begin, go to the Admin Functions menu item.  Select Temporary Closures > 

Create.   

 

Closure List for coalition displays. Click the Add Closure button.   

 

The Create Temporary Closure page displays.  Complete the form. Hover over the information icons for additional 

information. Click Save when complete. 

a. Closure Type = When an entire site is temporarily closed due to emergency circumstances, where all programs 

and children impacted, select “Yes.” 

b. Provider Information = When all sites within a county are temporarily closed due to emergency circumstances, 

check the “Select All” option. 

NOTE: If providers were closed for different dates, they should be unchecked and have separate closure events 

created. Additionally, if the coalition serves multiple counties, separate closure events must be created by county. 

c. Closure Details = Enter the closure date range. The “From” date is the first day of the closure and the “To” date 

is the last day of the closure. A single day closure would have the same “From” and “To” date. Next, enter the 

reopen date. Then, select “Closure Reimbursable (CR)” and enter a description. 
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These steps will add closure dates to the provider attendance roster, so no attendance will be collected, and 

includes the closure dates as reimbursable for all providers selected. 
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 Provider Attendance View (SR) 

 

Coalition Have Attendance View (SR) 

 

Coalition Closed Attendance View (SR) 
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Provider Attendance View (VPK) 

 

 Coalition Have Attendance View (VPK) 

 

 Coalition Closed Attendance View (VPK) 
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Updating VPK Class Calendar 
After the coalition creates a temporary/emergency closure, VPK providers have additional steps to complete the 

process.  

On the Provider Portal dashboard select Contracts > Manage Contracts or click the VPK Provider Application link 

under Common Tasks. 

 

Click the Edit button for the VPK-APP.  

 

Click the VPK Calendars tab to open the calendar section. 
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Click the Edit button to make changes to the calendar. Click the arrow to scroll to the particular calendar month to 

make edits/changes. 

NOTE: The system defaults to the first calendar month of the class. 

 

Select the desired emergency closure day(s) by clicking on the day(s) within the calendar. 

NOTE: Multiple days may be selected by clicking and dragging days. 
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After selecting a day, a pop-up will appear. There are two event types available. 

Instructional Day Exception – use if provider does not plan to make up calendar days for the emergency closure (up 

to 5 days permitted). 

Non-Instructional Day – use if provider plans to deduct the calendar hours for the emergency closure days and 

revise its class calendar to restore days. 

 

 

  Instructional Day Exception 
For closures that do not reduce hours, select Instructional Day Exception as the event type. 
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Once the Instructional Day Exception is selected, the provider will enter a description and time range for the 

particular day(s) they were closed. In the image below, the description example uses the verbiage “Closed due to 

Hurricane Dorian.” The provider will have to choose the same time range for the days as they listed on their 

calendars. Any hours chosen outside of their Start and End times will change their total calculated hours. Click 

Update. 

NOTE: If the provider has different instructional hours per day, a separate exception day event should be created 

for each day (i.e. Mondays are 3 hours and Tuesdays are 3.5 hours) so that the exact hours of the instructional day 

are entered for the exception day event. 
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The information is displayed on the calendar. The total calculated class hours and total instructional days have not 

changed. Click Save. 

NOTE: These steps must be completed for each impacted calendar. For example, some providers may have a 

morning VPK class using calendar A and an afternoon VPK class using calendar B. Since both calendars were 

impacted due to the closure, both calendars must be edited. 

 

When all impacted calendars are updated, click on the Certify and Submit tab. Complete the signature information 

and click the Submit VPK Provider Application button. 
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Non-Instructional Day 
For providers that will deduct the calendar hours for those days and revise its class schedule to restore days, select 

Non-Instructional Day as the event type. 

 

Once the Non-Instructional Day type is selected, the provider will enter a description for the particular day(s) they 

were closed. In the image below, the description example uses the verbiage “Closed due to Hurricane Dorian.” 

Click Update. 
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The totaled calculated hours will be reduced for each non-instructional day based on the hours defined for the day. 

Next, make the appropriate change to the calendar to add the make-up days. This can be accomplished in a variety 

of ways such as canceling previously identified non-instructional days, extending the class end date, or even 

extending the time on some instructional days (by creating exception days with different hours). When complete, 

click Save. 

NOTE: These steps must be completed for each impacted calendar. For example, some providers may have a 

morning VPK class using calendar A and an afternoon VPK class using calendar B. Since both calendars were 

impacted due to the closure, both calendars must be edited. 
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When all impacted calendars are updated, click on the Certify and Submit tab. Complete the signature information 

and click the Submit VPK Provider Application button. 
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Verifying VPK Class Calendar 
Coalition users should monitor the Provider> VPK Applications> Submitted work queue for Submitted VPK provider 

applications. Click on the contract ID to review changes. 

 

New or changed items requiring verification, such as calendars, classes, and documents, display a Verify button. 

Each tab should be reviewed for changes. For closure specific changes, go to the VPK Calendars tab to review 

calendar changes. Click Verify to accept the changes. When all tabs have been reviewed, click the Change Status 

button to change the contract status back to Certified. Remember, calendars and classes must be verified and have 

a Certified VPK provider application status in order for providers to process enrollments or attendance. 

 

 

 

 

 

 

 

 


